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Welcome

 

Thank you for purchasing the BJC-85 Color Bubble Jet Printer.

 

Printer Documentation

 

The documentation for your printer consists of these items:

 

� 

 

Quick Start Guide

 

Shows you how to set up the printer and prepare it for operation according to your computer 
system. You may also need your computer manual for reference during setup.

 

� 

 

User’s Manual (this manual)

 

Shows you everything you need to know about using the printer efficiently and safely. A 
detailed troubleshooting section provides step-by-step guidance for identifying and solving 
printing problems.

This 

 

User’s Manual

 

 provides complete explanations of the features and functions of the 
printer. To maximize the life of your printer, it’s a good idea to familiarize yourself fully with 
all of its functions.
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Printer Documentation

 

� 

 

Conventions

 

This 

 

User’s Manual

 

 uses the following symbols to indicate important information. Always 
observe the instructions indicated by these symbols.

Cautions alert you to ways to avoid injury to yourself, damage to the 
printer, or the loss of valuable data.

Notes provide advice, tips, and suggestions that are intended to help you 
work more efficiently with the printer.

This arrow and blue text indicate a link to where you can find more 
information about the current subject.

This manual uses the following symbols depending on the computer system you are using. 
Always observe the instructions indicated by these symbols.

Indicates information for Windows

 

®

 

 98, Windows 95, Windows NT, and

Windows CE users only.

Indicates information for iMac

 

™

 

 and Power Macintosh

 

®

 

 G3 users only.

Throughout this guide the names Microsoft

 

®

 

 Windows

 

®

 

 98, Microsoft

 

®

 

 Windows 95, 
Microsoft Windows NT

 

®

 

 4.0, and Microsoft Windows CE

 

®

 

 2.1 are abbreviated, respectively, 
as Windows 98, Windows 95, Windows NT, and Windows CE.

Note

Caution

Windows

Macintosh
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How to Use This Manual

To view this User’s Manual, please use Acrobat Reader 4.0, which is included on your 
CD-ROM, or a later version of Acrobat Reader.

Use this button when you wish to 
enlarge the screen you are viewing. 
Select this button in the tool bar, and 
then click within the screen of the 
User’s Manual. Use this button to display the 

next page of the User’s
Manual.

Use this button to 
return to the page 
you were viewing 
previously. This 
button moves you 
back from another 
page.

This arrow and blue text 
indicate a jump to another 
location in the User’s
Manual where the topic 
shaded in blue is 
discussed.

Use this button to display the 
previous page of the User’s 
Manual.
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How to Use This Manual

This column displays a table of contents for the User’s Manual. 
Click the desired item to jump to the topic.
Click the + (or   ) symbol when you wish to see detailed headings for each chapter.
Click the – (or �) symbol when you wish to return to the original (condensed) display.

Use this button when 
you wish to search 
for a word.

�
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Copyright

 

This manual is copyrighted by Canon Computer Systems, Inc. (CCSI) 
with all rights reserved. Under the copyright laws, this manual may not 
be reproduced in any form, in whole or part, without the prior written 
consent of CCSI.

© 2000 Canon Computer Systems, Inc.

 

Disclaimer

 

Canon Computer Systems, Inc. has reviewed this manual thoroughly 
in order to make it an easy to use guide for your Canon BJC-85 
Color Bubble Jet Printer. All statements, technical information, and 
recommendations in this guide and in any guides or related documents 
are believed reliable, but the accuracy and completeness thereof are not 
guaranteed or warranted, and they are not intended to be, nor should they 
be understood to be, representations or warranties concerning the 
products described.

Your printer and the software media included with your printer have been 
sold to you subject to the limited warranties set forth in the warranty card 
and license agreement enclosed with the respective products. All software 
is licensed AS IS, as described in the license agreement enclosed with the 
software media. Further, CCSI reserves the right to make changes in the 
specifications of the products described in this guide at any time without 
notice and without obligation to notify any person of such changes.
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Trademarks

Canon, BCI, BJ, Bubble Jet, and Drop Modulation Technology are trademarks, and 
SelectExchange is a service mark of Canon Inc. 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the U.S. and 
other countries.

Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and 
other countries. 

All other product and brand names are trademarks or service marks of their respective 
owners.

ENERGY STAR® COMPLIANT

As an ENERGY STAR® Partner, Canon U.S.A., Inc. has determined that this product meets the 
ENERGY STAR® guidelines for energy efficiency.
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FCC Regulations

 

Color Bubble Jet Printer, Model K10190

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.

Note: This equipment has been tested and found to comply with the limits for Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to
  which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.
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Use of shielded cable is required to comply with Class B limits in Subpart B of Part 15 of 
FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in 
the manual. If such changes or modifications should be made, you could be required to 
stop operation of the equipment.

 

Canadian Radio Interference Regulations

 

This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus as set out in the interference-causing equipment standard entitled “Digital 
Apparatus,” ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux 
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur: 
“Appareils Numériques,” NMB-003 édictée par l’Industrie et Sciences Canada.
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Safety Precautions

Please read the safety warnings provided in this manual to ensure that you use the printer 
safely. Do not attempt to use the printer in any way not described in this manual as this 
could result in unforeseen printer faults or cause a fire or electric shock.

Printer Location

Power Outlet and Power Cord

Cleaning the Printer

BJ Cartridges

General Warnings

Universal AC Adapter
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Safety Precautions

 

�

 

 Printer Location

 

The electrical contacts inside the printer become hot during normal 
operation. To avoid causing a fire or dangerous electrical shock, 
never store volatile substances such as alcohol or thinner near the 
printer. 

To avoid damage to the printer or possible personal injury, place 
the printer on a flat, stable surface that is safe from sudden shocks 
or strong vibrations to ensure that it will not fall.

To avoid damage to the printer that could result in a fire or 
electrical shock, place it in a location that is protected from dust, 
direct sunlight, high temperature, and high humidity. Use the 
printer in an environment where temperature and humidity are 
within the ranges of 41 to 95°F (5 to 35°C) and 10 to 90% RH 
(with no condensation).

To avoid dropping and damaging the printer, always hold the 
printer by both ends and carry it level. Do not pick up or hold the 
printer by any part.
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Safety Precautions

 

�

 

 Power Outlet and Power Cord

 

The socket-outlet shall be installed near the equipment and shall be easily accessible.

To avoid personal injury from an electrical shock, never handle the 
power cord or plug when your hands are wet.

To avoid causing a fire or serious electrical shock, make sure that 
the power plug is securely and completely inserted into the power 
outlet.

To avoid causing a fire or serious electrical shock, never use any 
type of power adapter other than the universal AC adapter 
provided with the printer.

To avoid a fire or serious electrical shock caused by a short circuit, 
avoid damaging the AC adapter cord or the power cord. Do not 
attempt to modify the cords in any way. Do not apply force to the 
cords by pulling on them nor place a heavy object on the cords.



 

16Introduction

Safety Precautions

 

To avoid a fire or serious electrical shock, do not knot the power 
cord or wrap it around itself.

To avoid damaging the power plug, which could cause a short 
circuit and cause a fire or electrical shock, do not pull on the power 
cord to unplug the cord from the power outlet. Grip the plug to 
remove it from the power outlet.

To avoid minor burns or minor injury from moving parts, press the 
POWER button to turn off the printer then unplug the power cord 
from the power outlet and allow the electrical contacts inside the 
printer to cool before cleaning the printer.



 

17Introduction

Safety Precautions

 

�

 

 Cleaning the Printer

 

Use only a damp, clean cloth to clean the surfaces of the printer. 
The electrical contacts inside the printer become hot during normal 
operation. To avoid a fire or serious electrical shock, do not use 
alcohol, benzene, thinner, or any other type of volatile liquid 
cleaner to clean the printer.

 

�

 

 BJ Cartridges

 

Store the BJ cartridges and ink tanks out of the reach of small 
children. If a child accidentally ingests ink from a BJ cartridge or 
ink tank, contact a physician immediately.

To avoid staining clothing or your work area with spilled ink, do not 
violently shake or drop a BJ cartridge.
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Safety Precautions

 

�

 

 General Warnings

 

There are high voltage points inside the printer. To avoid a fire or 
electrical shock, do not attempt to disassemble the printer or 
attempt repairs.

To avoid a fire or electrical shock, do not use volatile sprays around 
the printer.

The electrical contacts of the BJ cartridge become extremely hot 
during normal operation. To avoid minor burns, do not touch the 
electrical contacts after removing the BJ cartridge from the printer.

To avoid minor injury from moving parts inside the printer, do not 
open the cover and insert your fingers into the printer while the 
printer is printing.
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Safety Precautions

 

To avoid damage to the printer from objects falling into it, resulting 
in a fire or electrical shock, do not place any object such as a 
stapler or liquid container on top of the printer.

If any object falls into the printer and damages it while it is printing, 
press the POWER button to turn it off and unplug the power cord 
from the power outlet. To avoid a fire or electrical shock, stop using 
the printer and call the Canon Customer Care Center.

 

 Getting Help From Canon

 

To avoid a fire or serious electrical shock, if the printer emits smoke 
or a strange odor, immediately press the POWER button to turn 
the printer off then unplug the power cord from the power outlet. 
Stop using the printer and call the Canon Customer Care Center.

 

 Getting Help From Canon

 

�

 

 Universal AC Adapter

 

When you pack the universal AC adapter for travel or storage, do 
not wrap the cord around the body of the AC adapter. Doing so 
may cause the cord to split or separate from the body of the AC 
adapter, which could cause a short circuit.
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Safety Precautions

 

�

 

 Printer Functions and Special Features

 

This section describes the functions and special features of your printer that you can enjoy 
when you print color documents and images.

 

High resolution color (720 dpi)

 

With the BC-11e Color BJ Cartridge installed in the printer, you can print up to 720 dpi 
(720 dpi horizontal 

 

×

 

 360 dpi vertical) to reproduce quality documents and images even on 
plain paper. The BC-11e Color BJ Cartridge employs two different sizes of ink droplets in 
varied patterns to create images of higher quality than ever before. The BC-10 Black BJ 
Cartridge prints crisp and clear text documents. The BC-12e Photo BJ Cartridge produces 
beautiful, natural color in photographic images captured with a scanner or digital camera.

 

A variety of interface connections

 

In addition to the standard parallel port, this printer includes a USB and infrared port. The 
USB connection can be used with an IBM

 

®

 

-compatible PC running Windows 98, an iMac, or 
Power Macintosh G3. The infrared port on an IBM-compatible PC with Windows 98 can be 
used for wireless printer connection between the printer and a computer. 

 

Special print media

 

Most of the special media available for use with other Canon Bubble Jet printers can be 
used with this compact printer.

 

Capturing originals with the optional Scanner Cartridge

 

By inserting the optional IS-12 Color Image Scanner Cartridge in place of the BJ cartridge, 
you can convert the printer into a scanner.

 

 Using the Optional IS-12 Color Scanner Cartridge
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Safety Precautions

 

�

 

 Options and Consumables

 

The following options and consumables are available for use with this printer. To get more 
information, visit our web site at 

 

www.ccsi.canon.com

 

.

 

Options

Consumables

 

Item Comment

 

Portable Kit NK-300 NiMH battery set with recharger
IS-12 Color Image Scanner Cartridge Color scanner option
Universal AC Adapter AD-360U AC adapter
SB-10 Ink Cartridge Storage Box Storage box for additional BJ cartridges
NiMH Battery Pack NB-300 Additional NiMH battery pack for portable kit

 

Items Comment

 

BC-10 Black BJ Cartridge Monochrome printing
BCI-10 Black Ink Tank Black ink for BC-10 Black BJ Cartridge 

BC-11e Color BJ Cartridge Color printing
BCI-11 Color Ink Tank Color ink for BC-11e Color BJ Cartridge
BCI-11 Black Ink Tank Black ink for BC-11e Color BJ Cartridge

BC-12e Photo BJ Cartridge Photographic printing
BCI-12 Photo Color Ink Tank Color ink for the BC-12e Photo BJ Cartridge 
BCI-12 Photo Black Ink Tank Black ink for the BC-12e Photo BJ Cartridge 
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Safety Precautions

 

Paper and special print media

 

Media Load Limit

 

Bubble Jet Paper 30 sheets
Brilliant White Paper 30 sheets
High Resolution Paper 10 sheets
Glossy Photo Paper 10 sheets
High Gloss Film 1 sheet
Glossy Photo Cards 1 sheet
Transparencies 10 sheets
Back Print Film 1 sheet
T-Shirt Transfer 1 sheet
Greeting Cards (1/4 fold) 1 sheet
Envelopes 5 envelopes
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Getting Ready to Print

 

Printer Parts and Their Functions

Turning the Printer On

Setting Up and Using a Wireless Connection
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Printer Parts and Their Functions

This section describes important parts of the printer and how they function.

� Front View

Top Cover (and Paper Rest)
Before you use the printer, 
open the top cover. The top 
cover supports paper fed 
into the sheet feeder.

Operation Panel
Operation Panel

Sheet Feeder
Feeds sheets of paper 
continuously to the printer.

Paper Release Lever
Press to release paper 
jammed in the printer.

USB Interface Connector
Provides the connection point for 
a USB interface cable from the 
computer.

Paper Output Slot
Printed sheets are 
ejected here.

Cartridge Cover
Open to change the 
BJ cartridge or to 
replace ink tanks.

Paper Guide
Adjusts to the 
size of the paper 
or special media.
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Printer Parts and Their Functions

� Back View

Power Connector
Provides the connection 
point for the universal AC 
adapter plug.

Parallel Interface Connector
Provides the connection point for a 
parallel interface cable between the 
printer and computer.

IrDA Interface Port
Provides a port for a wireless IrDA connection 
between the printer and computer. This port should 
face the IrDA port of the computer. The port glass can 
be pulled out to adjust the position angle.
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Printer Parts and Their Functions

� Operation Panel

• If you will not be using the printer for a long period of time, turn off the 
printer; then remove the AC adapter power cord from the 
power outlet.

• Always press the POWER button to turn the printer off before you
remove the AC adapter power cord from the power outlet. If the power
cord is unplugged before the printer is turned off with the POWER
button, the BJ cartridge will not return to the home position and may dry
out which could cause the BJ cartridge to become unusable.

CARTRIDGE
ERROR

POWER RESUME

POWER Button
Press to turn the 
printer on and off.

Turning the
           Printer On

CARTRIDGE Button
Press to move the 
cartridge holder to the 
center in order to switch 
BJ cartridges or to 
replace ink tanks and to 
return the cartridge 
holder to the home 
position when you are 
finished.

RESUME Button
Press to release the printer from an error after the 
cause of the error has been removed. Pressing this 
button has no effect on unrecoverable errors. 

When no error exists, press once to feed a sheet of 
paper. If paper is partially fed into the printer, the sheet 
will be ejected.

Press and hold down until the printer beeps twice then 
release to start print head cleaning.

Cleaning the Print Head

POWER Light
Tells you whether or not the printer is on.
On Lights green when the printer is standing 

by and ready for normal operation.
Off Printer power is turned off.
Flashing Printer is warming up after power on, or 

is receiving a print job from the printer.

ERROR Light
Lights or flashes orange when an error 
occurs.

ERROR light is orange

Note
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Printer Parts and Their Functions

 

�

 

 POWER and ERROR Lights

 

The POWER and ERROR lights tell you the current status of the printer.

For details about what to do when these errors occur, see the Troubleshooting section of 
this manual.

 

 Troubleshooting

 

Light Status What It Means

 

POWER Off Printer is off.

On Printer is standing by and ready for normal operation.

Flashing Indicates one of the following:
• Printer is warming up.
• Printer is performing print head cleaning.
• BJ cartridge is being changed or ink tank is being replaced.
• Printer is receiving a print job from the computer.

ERROR Flashing Indicates one of the following:
• If the printer beeps twice, ink supply is low in an ink tank.
• If the printer beeps three times, the low-ink alert feature is on 
 and an ink tank is empty.

• Battery power is low. If the printer beeps four times, the optional 
 Portable Kit NK-300 power is low.

• If the printer beeps five times, the waste ink tank is full.
On Indicates one of the following:

• If the printer beeps once, paper feed error.
• If the printer beeps twice, paper jam.
• If the printer beeps three times, BJ cartridge is not installed.
• If the printer beeps four times, wrong BJ cartridge is installed.

POWER, 
ERROR

Both flashing

Unrecoverable error has occurred. Call the Canon Customer 
Care Center.

 

 Getting Help From Canon

ERROR

ERROR

ERROR
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Turning the Printer On

 

1

 

Make sure that the AC adapter is securely connected to the printer.

 

2 Open the top cover.

3 Press and release the POWER button to turn the printer on.

If a BJ cartridge is not installed, the POWER light continues to flash and the 
printer will beep three times.

If a BJ cartridge is installed, the POWER light will flash while the printer 
warms up. When the light stops flashing, the printer is ready for normal 
operation.

CARTRIDGE
ERROR

POWER RESUME
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Setting Up and Using a Wireless Connection

If you have a computer with an infrared port for wireless data transmission, you can set 
up a cordless connection with the printer using the IrDA method to effect infrared data 
transmission.

Before you can set up an infrared connection with the printer, you must perform several 
settings on the computer. Make sure that you read the section below before you set up the 
connection.

� What You Need for Infrared Data Transmission
In order to use infrared data transmission, you need the Windows 98 plug and play 
Microsoft infrared driver Version 3.0. The following items are required in order to set up 
wireless data transmission between the printer and computer via the infrared ports on the 
printer and your computer.

Computer IBM PC/AT or a compatible computer
CPU Intel® Pentium® or faster
IrDA IrDA 1.1 or later
Baud rate 
(transmission speed)

Max. 4 Mbps

Infrared transmission 
device

Built-in infrared port on the computer, or an infrared 
transmission adapter connected to the parallel or 
serial port.

Operating system Windows 98
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Setting Up and Using a Wireless Connection

If you are using Windows 95, you need IrDA 1.0 with a maximum baud rate 
of 115.2 kbps, and the Microsoft infrared port driver Version 2.0. 
For details about installing the infrared port, refer to your computer 
documentation.

� Confirming That the Infrared Transmission Driver Has Been Installed

1 Click Start, select Settings, and click Control Panel to open the Control 
Panel Window.

2 Look at the Control Panel window and confirm that the Infrared Monitor 
icon is displayed.

If the Infrared Monitor icon is displayed, the required infrared transmission 
driver is already installed.

If the Infrared Monitor icon is not displayed, refer to your Windows 
documentation for instructions on installing the infrared driver.

� Using Infrared Data Transmission

To set up infrared data transmission, refer to your computer 
documentation.

1 Make sure the universal AC adapter is connected securely.

2 Open the top cover.

Note

Note
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Setting Up and Using a Wireless Connection

3 Set the computer for infrared transmission.

If you are using Windows 98 or Windows 95, open the Control Panel and 
double-click the Infrared Monitor, click the Options tab, then click the 
“Enable infrared communication” check box (make sure a check mark is 
present). 

Open the printer driver directly and select the infrared port for the printer. 
Click Start, select Settings, and click Printers. Right-click the Canon 
BJC-85 printer icon and select Properties from the pop-up menu. Select 
the Details button, click the down-arrow for the “Print to the following port” 
option, then select the infrared port. For example:

     COM4 (Infrared Serial (COM) Port)

Some computers may allocate COM and LPT ports for infrared ports 
differently. For details refer to your computer documentation.

4 Arrange the computer with the printer so the infrared ports are facing each 
other and not more than three feet (0.8 meter) apart.

The distance between the computer and the printer may be different for 
some units; for details refer to your computer documentation.
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Setting Up and Using a Wireless Connection

• Make sure nothing is between the infrared ports that could block the data 
transmission.

• Make sure nothing interferes with the print data transmission while a 
print job is executing. If the print job halts, turn the printer off and cancel 
the print job on the computer. Open the Infrared Monitor on the Control 
Panel to confirm whether the IrDA connection has been broken.

Note

Printer infrared interface
port face plate

Within 3 feet/0.8 meter 
(with no obstructions) Effective range

(up, down, left, right 15°)

Computer with infrared port

Max. 75°
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Printing

Paper and Other Print Media

Loading Paper in the Printer

Changing BJ Cartridges
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Paper and Other Print Media

• Always handle paper and special print media by the edges, and avoid touching 
the print surfaces of the sheets. If the print surface is soiled or scratched, the 
print quality will deteriorate.

• Always store unused paper and special print media in its original package. Do 
not bend the media. Store the package flat, in a cool location that is not exposed 
to high temperatures, high humidity, or direct sunlight.

• Do not use media that is excessively curled, creased, or in any other way 
defective. If the media is curled, you may be able to remove the curl by bending 
the media in the opposite direction before loading it in the printer.

After printing, do not allow any moisture to contact the printed surface.

0.2 in.

To straighten curled media, 
bend it through an arc of 
0.2 inches (5 mm) in the 
direction opposite the curl 
until it is straight.

Make sure that 
envelopes are not 
curled more than 
0.2 in. (5 mm).

Hold the edges of the 
stack diagonally and 
bend gently.

Note
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Paper and Other Print Media

� Media You Can Use With This Printer
You can use any of the media listed in the table below.

Before you execute a print job, open the printer driver and select settings for Paper Size,
Media Type, and Paper Feed that match the media loaded in the printer. 

 Printing With Windows
 Printing With Macintosh

*Stack one sheet of plain paper behind the media before loading in the sheet feeder.

Media Load Limit Print Side
Printer Driver Settings

Page Size Media Type

Plain Paper 30 sheets Indicated on 
package

Letter, Legal, 
A4, B5, A5

Plain Paper

Brilliant White Paper 30 sheets Either side Letter, Legal Plain Paper
High Resolution 
Paper

10 sheets Whiter side Letter, A4 High Resolution 
Paper

Glossy Photo Paper 10 sheets Glossy side Letter, A4 Glossy Photo 
Paper

High Gloss Film 1 sheet Film side Letter, A4 High Gloss Film
Glossy Photo Cards 1 sheet Glossy side Letter, A4 Glossy Photo 

Cards
Transparencies 10 sheets Either side Letter, A4 Transparency
Back Print Film 1 sheet* Matte side Letter, A4 Back Print Film
T-Shirt Transfer 1 sheet* Unlined side Letter, A4 T-Shirt Transfer
Greeting Cards 1 sheet See package Letter, A4 Other Paper
Envelopes
US Com. No. 10
European DL

5 envelopes
5 envelopes

Smooth side
Smooth side

#10 Env.
DL Env.

Envelope
Envelope
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Paper and Other Print Media

� Printing Area
Print within the area marked by the darkest shading in the illustration below.

 Printing Area

0.12 in./
3.0 mm(*1) 0.87 in./

22 mm

0.28 in./
7.0 mm(*2)

0.13 in./
3.4 mm(*3)

0.13 in./
3.4 mm(*4)

0.87 in./
22 mm

Printing in this area is possible but not 
recommended. Printing may degrade in this 
area due to variations in the precision of 
paper feed, and printing may run over the 
bottom edge of the sheet.

Recommended print area for optimum 
results.

*1 Glossy Photo Cards: 1.10 in./28.0 mm
*2 Glossy Photo Cards: 1.0 in./26.0 mm
*3 Letter, Legal: 0.25 in./6.4 mm

Glossy Photo Cards: 0.16 in./4.0 mm
*4 Letter, Legal: 0.25 in./6.3 mm

Glossy Photo Cards: 0.20 in./5.0 mm
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Paper and Other Print Media

� Plain Paper
• Use Canon Bubble Jet Paper or any plain copier paper that meets the 

requirements listed below. You cannot use continuous feed paper with this 
printer.

• You can load up to 30 sheets of plain paper in the sheet feeder. However, you 
can load only one sheet of legal paper at a time.

• Do not allow printed sheets of plain paper ejected from the printer to stack higher 
than 20 sheets. For all other types of paper and special media, do not allow the 
printed sheets to stack; remove each sheet as it is ejected from the printer.

Plain Paper Specifications

Paper Size Letter
Legal
A4
B5
A5

8.5 × 11 in.
8.5 × 14 in.
210 × 297 mm
182 × 257 mm
148 × 210 mm

Weight 17 to 28 lb. (64 to 105 g/m2)
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Paper and Other Print Media

� High Resolution Paper
• Canon’s High Resolution Paper is recommended for use with this printer.

• Print only on the coated (whiter) side of each sheet.

• Store unused High Resolution Paper in its original package. Store it flat, in a cool 
location that is not subject to high temperature or high humidity and protected 
from direct sunlight.

• To prevent fading from long exposure to direct sunlight, cover each printed sheet 
with a sheet of plain paper and store it in a dark location.

� Glossy Photo Paper
• Canon’s Glossy Photo Paper is recommended for use with this printer. Before 

you use this media, read the instructions provided with the package.

• Print only on the glossy (whiter) surface of each sheet.

• To prevent fading from long exposure to direct sunlight, cover each printed sheet 
with a sheet of plain paper and store it in a dark location.

• Allow about two minutes for ink to dry on Glossy Photo Paper.
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Paper and Other Print Media

� High Gloss Film
• Canon’s High Gloss Film is recommended for use with this printer. Before you 

use this media, read the instructions provided with the package.

• Do not use High Gloss Film in conditions of high humidity.

• Print only on the film surface of each sheet.

• Feed High Gloss Film manually, one sheet at a time.

• Do not allow printed sheets to stack. Handle printed sheets carefully until the ink 
has completely dried. Drying requires 10 to 20 minutes.

• To store the printed sheets after they have dried, while avoiding touching the 
printed surface, cover the printed surface of each sheet with one sheet of plain 
paper.

� Glossy Photo Cards
• Canon’s Glossy Photo Cards are ideal for printing photographic images.

• The cards have borders slightly larger than the print area. Separate the borders 
from the cards at the perforations only after printing has been completed.

• Before you use this media, read the instructions provided with the package.

• Allow about two minutes for ink to dry on Glossy Photo Cards.
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Paper and Other Print Media

� Transparencies
• Canon’s Transparencies are recommended for use with this printer. Before you 

use this media, read the instructions provided with the package.

• Do not use transparencies intended for use with a photocopier or laser printer.

• Do not attempt to print on transparencies in a location where humidity is high.

• You can print on either side of transparencies.

• Do not stack transparencies after printing. Allow at least 15 minutes for the ink 
on printed transparencies to dry, and do not touch the printed surfaces.

• To prevent printed transparencies from sticking together, cover the printed 
surface of each sheet with one sheet of plain paper. Cover each transparency 
with a sheet of plain paper, even before storing them in a plastic folder.
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Paper and Other Print Media

� Back Print Film
• Canon’s Back Print Film is recommended for use with this printer. Before you 

use this media, read the instructions provided with the package.

• When you select Back Print Film for the Media Type, the document image is 
reversed or “mirrored” when it is printed so it will display correctly when placed 
on a backlight device.

• Do not attempt to print on back print film in a location where humidity is high.

• Always print on the non-reflecting, rough side of back print film.

• Before you set a sheet of back print film in the printer, with the print side facing 
up place one sheet of plain paper behind the film. Align the edges and set the 
sheets in the printer with the film on top and its print side facing up.

• Always feed back print film manually, one sheet at a time.

• Do not stack the sheets after printing. Allow at least 15 minutes for the ink on 
printed sheets to dry, and do not touch the printed surfaces.
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Paper and Other Print Media

� T-Shirt Transfers
• Canon’s T-Shirt Transfers are recommended for use with this printer. Before you 

use this media, read the instructions provided with the package.

• When you set a transfer in the printer, always load the side with the green lines 
facing down.

• Always feed a transfer manually one sheet at a time.

• For detailed instructions about how to apply a transfer to a T-shirt, refer to the 
instructions that you received with the T-Shirt Transfer package.

� Greeting Cards (1/4 fold)
• Get the most out of your Canon Creative or other card making software with 

Canon Greeting Cards.

• These cards give your unique, personalized cards the look and feel of 
professional cards.

• You can create cards, invitations, announcements, and more.

• You can use Greeting Cards that come in 1/4-fold only.

• In the printer driver, select Other Paper for the Media Type.

• Load these greeting cards with the words “Canon Greeting Cards” face down.
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Paper and Other Print Media

� Envelopes
• Use only US Commercial #10 or European DL envelopes with this printer.

• Before loading envelopes in the printer, press down on the center of the stack to 
expel all the air inside the envelopes, crease the edges if they are not perfectly 
square, and bend the envelopes opposite to the direction of the curl if they are 
curled.

• If the envelopes do not feed smoothly, use a pen 
or other flat object to crease the leading edges of 
the envelopes. 

• To prevent feed problems, make sure none of 
the flaps are overlapping, and do not use 
self-sealing envelopes.

• Do not attempt to feed envelopes that have been heavily embossed or treated 
with any type of special coating or coloring.

Press down on the stack on the 
edges, the center, and corners 
to ensure that all the air is 
expelled from the envelopes.

Press down the flaps.
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Loading Paper in the Printer

You can use either of two methods to feed paper to the printer.

Auto Feed Set a stack of sheets for continuous feed. The number of sheets you  
can load is determined by the type of media you are using. 

 Media You Can Use With This Printer

Manual Set one sheet at a time manually for printing on thick paper and other  
media that requires manual feed.

 Media You Can Use With This Printer

1 Open the top cover and slide the paper guide completely to the left.

Paper Guide

Auto Sheet Feeder
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Loading Paper in the Printer

2 Pick up a stack of paper and fan it. Tap the edges on a flat surface to align 
them.

3 Set the stack in the printer.

Align the stack with the right side of the sheet feeder, and insert the stack 
into the printer until it stops.

Sheet Feeder Print Side
Set the stack with the print 
side facing up.

If loading letterhead, make sure the 
letterhead side is up and pointing 
down into the printer.

Align the edge of the stack with the 
right side of the sheet feeder.

Top Cover
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Loading Paper in the Printer

4 Slide the paper guide to the edge of the stack.

Make sure that the paper guide is not too tight against the side of the stack. 
If there is a gap between the paper guide and the stack, or if the paper 
guide is too tight, the paper may feed incorrectly.

The number of sheets that you can load depends on the paper or special 
print media that you are using. However, in conditions of high humidity if 
you experience problems with paper feed, reduce the number of sheets in 
the auto sheet feeder.

5 Set up the print job with the printer driver and start the print job.

You can change paper size, paper type, and other important settings in the 
printer driver.

 Printing With Windows

 Printing With Macintosh

Note
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Changing BJ Cartridges

You can use these BJ cartridges with this printer:

BC-11e Color BJ Cartridge Printing in color

• BCI-11 Color Ink Tank

• BCI-11 Black Ink Tank

BC-10 Black BJ Cartridge Printing in monochrome (black ink only)

• BCI-10 Black Ink Tank

BC-12e Photo BJ Cartridge Printing photographic images in color

• BCI-12 Color Ink Tank

• BCI-12 Black Ink Tank

• You can use the BC-11e Color BJ Cartridge to print black only. However, 
for large monochrome print jobs, like a document that contains mainly 
text, always use the BC-10 Black BJ Cartridge.

• To avoid damaging the printer, do not touch the orange film cable under 
the cartridge cover.

Note



48Printing

Changing BJ Cartridges

1 Make sure that the printer is turned on and open the cartridge cover.

2 Press the CARTRIDGE button to move the cartridge holder to the center.

3 Remove the BJ cartridge.

Lift up on the green tab to remove the BJ cartridge from the cartridge 
holder.

Green Tab

Cartridge Cover
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Changing BJ Cartridges

4 Immediately store the BJ cartridge you just removed in an Ink Cartridge 
Storage Box. 

• When you are not using a BJ cartridge, always store it in an Ink
Cartridge Storage Box. Do not attempt to re-attach the orange protective
tape or protective cap to a BJ cartridge.

• Close the storage box lid tightly to prevent the BJ cartridge print head
from drying out and causing the BJ cartridge to become unusable.

Note

Align these marks (  )

Storage box lid
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Changing BJ Cartridges

5 Prepare the new cartridge for installing in the printer.

If you are installing a previously used BJ cartridge, remove it from its 
storage box.

If you are installing a new BJ cartridge, pull off the top of the package and 
remove the BJ cartridge. Invert the BJ cartridge with the label side down; 
then remove the orange protective cap and the orange protective tape.

Remove the orange 
protective cap.

Remove the orange 
protective tape.

Print Head 
Do not touch this area.
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Changing BJ Cartridges

• To avoid damage to the printer, make sure you always remove the
orange protective cap and orange protective tape from a new BJ
cartridge before you install it in the printer.

• To avoid minor cuts, do not touch electrical contacts on the BJ cartridge.

• To prevent dropping the BJ cartridge and spilling ink on your clothing or
around the work area, always turn the BJ cartridge upside down before 
you remove the orange protective cap and tape.

• Always handle the BJ cartridge carefully. Ink stains cannot be removed
from clothing.

• To prevent staining your hands or damaging the print head, do not touch
the print head. After removing the orange protective cap and tape,
discard them immediately and do not attempt to re-attach them to a 
BJ cartridge.

Caution
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Changing BJ Cartridges

6 With the label side up, set the BJ cartridge into the cartridge holder at a 
slight angle.

Align the marks ( ) on the BJ cartridge with the marks on the holder. This 
illustration shows the BC-10 Black BJ Cartridge being installed in the 
printer. The BC-11e Color BJ Cartridge has similar marks that must also be 
aligned for installation.

Align These Marks



53Printing

Changing BJ Cartridges

7 Press down on the raised left side of the BJ cartridge until it locks in place.

8 Close the cartridge cover.

9 Press the CARTRIDGE button.

The printer moves the cartridge holder to the home position and 
automatically starts cleaning the print head. The POWER light flashes 
during the print head cleaning. Print head cleaning is complete and the 
printer is ready for operation when the POWER light remains on.

After installing the BJ cartridge in the holder, it takes about two seconds for 
the printer to recognize the BJ cartridge. So there may be a slight delay 
after pressing the CARTRIDGE button.

Press Here 

Note



54Maintaining the Printer

Maintaining the Printer

Printing a Nozzle Check Pattern

Cleaning the Print Head

Using the Low-Ink Alert

Replacing Ink Tanks

Replacing a BJ Cartridge

Cleaning the Printer

Performing the Test Print

Transporting the Printer
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Printing a Nozzle Check Pattern

If you see colors missing or broken in your printed output, print a Nozzle Check Pattern to 
determine the condition of the print head.

If the BC-11e Color BJ Cartridge or BC-12e Photo BJ Cartridge is installed in the printer, 
four colors (black, cyan, magenta, yellow) will be printed in the Nozzle Check Pattern. If the 
BC-10 Black BJ Cartridge is installed, only a black pattern will be printed.

If the horizontal lines in the Nozzle Check Pattern are broken or irregular, the print heads 
may be clogged and require cleaning.

To print a Nozzle Check Pattern, follow these steps:

1 Set a sheet of plain paper in the printer.

2 Press the POWER button to turn the printer off.

3 Press and hold down the POWER button until you hear the printer beep 
four times then release it.

The Nozzle Check Pattern begins to print. The printer prints one page and 
then stops.

You can also use the printer driver to print a Nozzle Check Pattern.

 Printing With Windows

 Printing With Macintosh
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Printing a Nozzle Check Pattern

� Normal Nozzle Check Pattern
Here is a sample of a normal Nozzle Check Pattern printed with the BC-10 Black 
BJ Cartridge.

Here is a sample of a normal Nozzle Check Pattern printed with a BC-11e Color 
BJ Cartridge or a BC-12e Photo BJ Cartridge.

Black

Yellow
Magenta
Cyan
Black



57Maintaining the Printer

Cleaning the Print Head

There are two methods for cleaning the print head.

� Print Head Cleaning 
Use this method to clean the print heads.

� Print Head Deep Cleaning 
Use this more thorough method only after five consecutive print head cleanings fail to 
produce a satisfactory Nozzle Check Pattern.

1 Make sure that the printer is turned on.

2 Press and hold down the RESUME button until you hear the required 
number of beeps and then release it.

Print head cleaning 2 beeps (about 2 seconds)
Print head deep cleaning 3 beeps (about 3 seconds)

CARTRIDGE
ERROR

POWER RESUME
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Cleaning the Print Head

Print head cleaning begins.

The POWER light flashes during print head cleaning. When print head 
cleaning is finished, the POWER light remains on, indicating that the 
printer is ready for operation.

After print head cleaning is complete, print another Nozzle Check Pattern. 
If the Nozzle Check Pattern is not satisfactory, repeat print head cleaning 
several times and print another Nozzle Check Pattern. If the results are 
still not satisfactory, perform print head deep cleaning once or twice. Print 
head deep cleaning flushes the print heads with ink and requires more 
time than print head cleaning.

If necessary, replace the ink tank(s).

 Replacing Ink Tanks

• Print head deep cleaning consumes a large amount of ink. Perform deep
cleaning only after five consecutive print head cleanings fail to correct
the problem. If you are sure the ink tanks are full, and deep cleaning 
does not solve the problem, the print head may be worn out or damaged. 
Replace the BJ cartridge.

 Replacing a BJ Cartridge

• You can also perform print head cleaning and print head deep cleaning
with the printer driver.

 Printing With Windows
 Printing With Macintosh

Note
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Using the Low-Ink Alert

This printer employs a low-ink alert that warns you when ink in an ink tank runs low. Before 
the printer is shipped from the factory, the low-ink alert is turned off.

To turn on the low-ink alert manually, follow these steps:

1 Press the POWER button to turn off the printer.

2 Press and hold down the POWER button until the printer beeps 8 times 
then release the POWER button.

When the low-ink alert is turned on, and the ink supply in an ink tank runs low, the ERROR 
light starts flashing orange. To determine which ink tank is about to run out of ink, open the 
cartridge cover and press the CARTRIDGE button to move the cartridge holder to the 
center. The type and number of flashes tell you which ink tank is about to run out of ink.

You can also turn on this feature with a simple procedure in the printer driver. 

  Printing With Windows
 Printing With Macintosh

Flashing Meaning

Steady flash Black ink tank requires replacement
2 alternating flashes Color ink tank requires reqplacement
3 alternating flashes Color and black ink tanks require replacement
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Using the Low-Ink Alert

� Resetting the Low-Ink Alert After Replacing an Ink Tank
You can reset the low-ink alert manually with the printer’s operation panel. After replacing 
the ink tank, press and hold down the RESUME button for the required number of beeps, 
depending on which ink tanks you replaced. 

Also, after a low-ink alert occurs, you can replace the ink tank from the Maintenance tab of 
the printer driver and reset the low-ink alert.

  Printing With Windows

 Printing With Macintosh

Replaced ink tank Press & Hold Until you hear

Black RESUME 1 beep
Color RESUME 2 beeps
Black and Color RESUME 3 beeps
Cancel selection RESUME 4 beeps
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Replacing Ink Tanks

When an ink tank runs out of ink, only the ink tank requires replacement.

• To ensure the best performance of the ink tanks, be sure to install them
within one year of the purchase date and use them within six months
after they are installed in the BJ cartridge.

• After replacing an ink tank, always press the CARTRIDGE button to
move the cartridge holder to its home position.

1 Make sure that the printer is turned on and open the cartridge cover.

2 Press the CARTRIDGE button to move the cartridge holder to the center.

Note

CARTRIDGE
ERROR

POWER RESUME

Cartridge Holder

Cartridge Cover
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Replacing Ink Tanks

3 If you have the BC-11e Color BJ Cartridge installed:
• Press in and lift the white tab to remove the BCI-11 Color Ink Tank.
• Press in and lift the gray tab to remove the BCI-11 Black Ink Tank.

If you have the BC-10 Black BJ Cartridge installed:
• Press in and lift the gray tab to remove the BCI-10 Black Ink Tank.

If you have the BC-12e Photo BJ Cartridge installed:
• Press in and lift the white tab to remove the BCI-12 Color Ink Tank.
• Press in and lift the gray tab to remove the BCI-12 Black Ink Tank.

Do not touch the green tab.

• You do not remove the BJ cartridge when you replace an ink tank. 
Leave the BJ cartridge installed in the printer. 

• Please dispose of empty ink tanks in accordance with any local laws
regarding the disposal of consumables.

or

Note
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Replacing Ink Tanks

4 Select a new ink tank; be sure to use the same type that you removed 
from the printer. Remove the new ink tank from its package and remove 
the orange protective cap.

To avoid interfering 
with the flow of ink and 
to ensure optimum 
performance of the BJ 
cartridge, do not touch 
the open ink port on 
an ink tank.BCI-11 Color or BCI-12 Color

BCI-11 Black or BCI-12 Black

BCI-10 Black

Orange 
protective cap

Orange 
protective cap

Orange 
protective cap
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Replacing Ink Tanks

5 Install the ink tank.

With the label up, set the ink tank in the BJ cartridge at a slight angle, then 
gently press down on the left, raised end of the ink tank until it locks in 
place.

If you have a BC-11e Color BJ Cartridge installed:

• Align the marks on the ink tank with the marks ( ) on the BJ cartridge.

• Press down on the left side until you hear the ink tank lock in place.

Color

BCI-11 Black

Align Marks Press Here
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Replacing Ink Tanks

If you have a BC-10 Black BJ Cartridge installed:

• Align the marks on the ink tank with the marks ( ) on the BJ cartridge.
• Press down on the left side until you hear the ink tank lock in place.

6 Close the cartridge cover and press the CARTRIDGE button.

The printer moves the cartridge holder to the home position and 
automatically starts cleaning the print heads. The POWER light flashes 
during the print head cleaning. Print head cleaning is complete and the 
printer is ready for operation when the POWER light remains on.

You can also perform ink tank replacement from the Maintenance tab of 
the printer driver.

 Printing With Windows

 Printing With Macintosh

Align Marks Press Here

Note
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Replacing a BJ Cartridge

Replace the BJ cartridge if print head deep cleaning fails to restore print quality. In this 
case, the print head may be damaged or worn out and requires replacement.

1 Make sure that the printer is turned on, then open the cartridge cover.

2 Press the CARTRIDGE button to move the cartridge to the center.

CARTRIDGE
ERROR

POWER RESUME
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Replacing a BJ Cartridge

3 Remove the BJ cartridge.

Lift the green tab to remove the BJ cartridge from the holder.

Dispose of the old BJ cartridge immediately.

Dispose of the old BJ cartridge in accordance with any local laws 
regarding the disposal of consumables.

Green Tab

Note



68Maintaining the Printer

Replacing a BJ Cartridge

4 Remove the new BJ cartridge from its package.

5 Remove the orange protective cap and the orange protective tape.

Print Head
Do not touch the 
print head area.

Remove the orange 
protective tape.

Orange 
Protective Cap
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Replacing a BJ Cartridge

6 With the label side up, set the BJ cartridge into the cartridge holder at a 
slight angle.

• Align the marks ( ) on the BJ cartridge with the marks on the holder. 
This illustration shows the BC-10 Black BJ Cartridge being installed in 
the printer. The BC-11e Color BJ Cartridge has similar marks, which 
must also be aligned for installation.

7 Press down on the raised left side of the BJ cartridge until it locks in place.

• Press down until you hear the BJ cartridge lock in place.

Align Marks

Press Here
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Replacing a BJ Cartridge

8 Close the cartridge cover.

9 Press the CARTRIDGE button.

The printer moves the cartridge holder to the home position and 
automatically starts cleaning the print heads. The POWER light flashes 
during the print head cleaning. Print head cleaning is complete and the 
printer is ready for operation when the POWER light remains on.

• After installing the BJ cartridge in the holder, it takes about 2 seconds 
for the printer to recognize the BJ cartridge, so there may be a slight
delay after pressing the CARTRIDGE button.

• You can also use the printer driver to change a BJ cartridge.

 Printing With Windows

 Printing With Macintosh

Note
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Cleaning the Printer

Follow the instructions in this section to clean the printer and keep it in good working order 
to prevent paper jams, poor paper feeding, and other problems.

Please follow these precautions and guidelines:

• Clean the surfaces of the printer only with a clean, damp cloth. To avoid a fire 
hazard, do not use alcohol, benzene, thinner, or any other type of flammable 
liquid that could come in contact with the hot electrical contacts inside the printer.

• Before you clean the printer, turn the printer off and unplug the power cord from 
the power outlet. To avoid accidentally turning the printer on during cleaning and 
causing an injury from moving parts inside the printer, always unplug the power 
cord before cleaning the printer.

• To prevent injury from the moving parts inside the printer, do not insert your 
fingers or hand into the printer while it is operating.

• The electrical contacts on the BJ cartridge become extremely hot during normal 
operation. To prevent minor burns, do not touch the electrical contacts on the 
print head.

• Keep paper clips, staples, pins, and all other types of fasteners away from the 
printer; these may accidentally fall into the printer.

• To avoid accidental spills into the printer, causing a dangerous short circuit, keep 
all liquids away from the printer. Do not use the printer near stored flammable 
liquids.
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Cleaning the Printer

• Do not use a paper towel or tissue that can shred and damage moving parts or 
jam the print head nozzles. Use only a clean, damp cloth to clean the printer.

• To avoid damaging or discoloring the top cover, do not use any kind of organic 
chemical or liquid cleaner to clean the surface of the printer.

• Clean carefully around the print head and film cable to avoid touching these 
parts directly and possibly damaging them.

• To avoid damage to the printer, do not use water or any other type of liquid to 
clean inside the printer.

� Cleaning the Underside of the Cartridge Cover
Open the cartridge cover. Use a clean, slightly damp cloth to wipe away paper dust from the 
underside of the cartridge cover (marked by shading in the illustration).
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Cleaning the Printer

� Cleaning Inside the Printer
After a paper jam, you may find ink sprayed on the left or right side of the platen. If you 
continue to print without cleaning the platen, the back sides of the next sheets to be printed 
could be stained with ink. Without touching the film cable, carefully wipe clean the portions 
of the platen marked by shading in the illustration.

� Cleaning the Printer Surfaces
Use a clean, slightly damp cloth to wipe dust and dirt from the surfaces of the printer.
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Performing the Test Print

 

In addition to the Nozzle Check Pattern, you can print a Demonstration test pattern. 

This test print demonstrates, with simple graphics and text, the color capabilities of this 
printer.
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Performing the Test Print

1 Set a sheet of plain paper in the printer.

2 Press the POWER button to turn the printer off.

3 Press and hold the POWER button until you hear one beep, then release 
it. The Demonstration beings to print.

You can also print the Demonstration from the Maintenance tab in the 
printer driver. 

 Printing With Windows

 Printing With Macintosh

Note
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Transporting the Printer

Follow this procedure to pack the printer carefully for transporting to a service center or for 
long term storage. Use the packing material that you saved when you unpacked the printer.

� Packing the Printer

1 Press the POWER button to turn the printer off.

2 If there is any paper in the sheet feeder, remove it.

3 Unplug the AC adapter power cord and interface cable from the printer.

If you have installed the battery from the optional Portable Kit NK-300, 
remove the battery.

4 Close the top cover.

You can leave the BJ cartridge installed in the printer.Note
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Transporting the Printer

5 Pack the printer and accessories in the original packing material.

• When you carry or handle the printer, always use two
hands to hold it to prevent accidentally dropping and
damaging it.

• If you are transporting the printer by automobile, do not
allow the printer to remain inside the vehicle if the
temperature is extremely hot or cold.

• Protect the printer from sudden shocks and strong vibrations during
transport.

Caution
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Transporting the Printer

� Shipping the Printer
Before shipping the printer by special delivery or post:

• Tape the lid of the box securely with strong tape.

• On the box write clearly FRAGILE or HANDLE WITH CARE.

� Travelling Abroad With the Printer
Here are some points to remember while travelling:

• You can use the universal AC adapter abroad to power the printer in countries 
where AC 100~240V is used. However, you may need to purchase a power cord 
for the countries where you intend to travel. 

• X-ray or any other type of baggage inspection device will have no effect on this 
printer.

� Universal AC Adapter AD-360U
The AC adapter is intended for use with this printer only; do not attempt to use the AC 
adapter with other appliances or equipment or as a power/voltage converter in another 
country. The power supply cord provided with purchase is for use in the United States or 
Canada only. For other countries, you may need a power cord rated for use with the local 
power supply. 
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Printing With Windows

Getting Ready to Print

Selecting the Print Mode

Changing the Page Size

Windows Printer Driver Features

Using the BJ Background Monitor

Using the BJ Backgrounder

Using the BJ Printer Status Monitor
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Getting Ready to Print

After you have created a document with your software application and you are ready to 
print, you’ll want to confirm the printer driver settings before printing.

The method of opening the printer driver may differ slightly, depending on 
the software application. For details about starting a print job, refer to the 
documentation for your software application.

1 First, open the printer Properties dialog box.
Normally, to open the printer driver from a software application, select 
Print from the File menu then click the Properties button in the Print dialog 
box.

Note
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Getting Ready to Print

2 Click the print mode icon best suited for the print job.

By clicking a print mode icon you automatically enable the recommended 
optimum settings for the type of document. After clicking on a print mode 
icon, select the BJ Cartridge and Media Type that you are using.

Page Size
Select the page size beforehand in the software application. The first time 
you open the printer driver, click the Page Layout tab and make sure the 
selected page size is the same size selected in the software application. If 
the selected page size on the Page Layout tab is different, click the down 
arrow and select the page size from the drop-down list.

 Changing the Page Size

Select a print mode icon.
Selecting the Print Mode

The BJ Cartridge and Media Type 
selections change automatically, 
depending on which print mode 
icon you select.

Check the Page Size selection.
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Getting Ready to Print

3 When you are finished with the print settings, click OK to close the printer 
Properties dialog box.

4 Confirm that the printer is turned on and that paper is set in the printer.

Click the OK button to 
close the printer 
Properties dialog box.
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Getting Ready to Print

5 Start the print job.

The procedure to start the print job may differ slightly, depending on the 
software application. Generally, you can start the print job by clicking the 
OK button in the Print dialog box after closing from the printer Properties 
dialog box.



84Printing With Windows

Getting Ready to Print

A screen like the one below is displayed during printing.

BJ Background Monitor
Click the button on the taskbar to view 
the jobs queued for printing and the 
status of the current print job.

 Using the BJ 
Background Monitor

BJ Printer Status Monitor
Click the button on the taskbar to open the BJ Printer 
Status Monitor to view the progress of the print job. 
The BJ Printer Status Monitor opens automatically 
and displays a message if the printer is not turned 
on, if no paper is loaded in the printer, or if any other 
problem occurs.

 Using the BJ Printer Status Monitor

BJ Backgrounder
Displays the progress of the 
current print job. You can also 
use the BJ Backgrounder to 
pause or halt the current print 
job.

 Using the BJ 
Backgrounder
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Selecting the Print Mode 

The following default Print Mode settings are available:

This Print Mode selects standard quality for documents that contain only 
word processed text. Use this setting when you have either the BC-10 
Black or BC-11e Color BJ Cartridge installed and you are using plain 
paper.

This Print Mode is for faster printing with slight loss in quality to print 
drafts for proofreading and checking; this setting consumes less ink.
Use this setting when you have either the BC-10 Black or BC-11e Color 
BJ Cartridge installed and you are using plain paper.

This Print Mode produces standard quality for documents that contain a 
mixture of text, graphics, photographs, and illustrations. Print quality is 
adjusted automatically by recognition of what is on the page (text, 
photograph). Use this setting when you have either the BC-10 Black or 
BC-11e Color BJ Cartridge installed and you are using plain paper.

This Print Mode is a good choice for color photographs or any type of 
image with gradations of color. It provides high quality printing with
the BC-11e Color BJ Cartridge.

This Print Mode is the best choice for photographs or any type of graphic 
image with a wide range of gradations in color tone. It provides the best
quality printing with a BC-12e Photo BJ Cartridge. High Resolution 
Paper is automatically selected and recommended for printing with this 
selection.
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� Selecting the Print Mode

1 In the Main tab of the printer Properties dialog box, choose one of the 
Print Mode icons.

The name and 
icon for the 
current setting 
are displayed 
here.



87Printing With Windows
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2 Make sure that the BJ Cartridge and Media Type settings are correct for 
the BJ cartridge and paper installed in the printer. If necessary, use the 
pull-down menus to change the settings.
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� Adjusting and Saving Print Mode Settings
If you change any of the default settings, you see the words “User-Modified” displayed 
below the icon.

You can print with the modified setting(s) one time (the defaults are restored immediately 
after the print job executes). If you intend to use these settings often, you can save the new 
print mode, and then select it easily the next time.



89Printing With Windows

Selecting the Print Mode

To save a new print mode

1 After changing the setting(s), right-click the User-modified icon and select 
Save As from the pop-up menu.
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2 Click the Title box and enter a name for the Print Mode settings.

3 Click the Save button and click the OK button.

The new print mode is saved and the settings are enabled as the current 
settings.

To remove a print mode

1 In the Choose Print Mode panel, right-click the icon that you want to delete 
and select Delete from the pop-up menu.

2 When the message asks you to confirm that you want to delete the print 
mode, click the OK button.
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Changing the Page Size

You usually select the page size with a setting in your software application.

The first time that you execute a print job, follow the procedure below to confirm that the 
page size setting in the software application is the same in the printer driver. If the settings 
are not the same, select the correct page size in the printer driver.

1 Open the printer driver and select the Page Layout tab.
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2 If the Page Size setting is not the same as the setting in the software 
application, click the down-arrow and select the correct page size from the 
drop-down list.

This example shows Letter selected. After making your selection, click the 
OK button.

Make sure the paper you load in the printer is the same size you select in 
the printer driver. If the size of paper in the printer and the Page Size 
setting do not match, the printer cannot execute your print job normally.

Note
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The printer Properties dialog box has four tabs with buttons and check boxes you use to set 
up a print job.

� Main Tab

Choose Print Mode The Print Mode icons hold the default settings for a 
variety of common print jobs.  

 Selecting the Print Mode
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Current Settings Displays the currently selected icon.

If you change any setting for a default icon, the 
“User-Modified” notation is displayed below the icon 
in the Current Settings box. You can use the current 
settings to execute the next print job, or you can 
register the settings as a new print mode. 

If the currently selected icon has just been deleted, 
the “No Info” notation is displayed. In this case, click 
another icon to select it.

BJ Cartridge Select a BJ cartridge from the drop-down list. Select 
Black, Color, or Photo.

Grayscale Print Check the box  to print a color image in 
grayscale. When Grayscale Print is off, color images 
are printed in color.

Media Type Select a Media Type from the drop-down list.
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Illustrated guideline The (A) graphic displays the current selections for 
the Orientation and Paper Feed method.

The Page Size, Orientation, and other settings 
change to reflect the settings on the Page Layout 
tab. 

 Page Layout Tab

If you select an envelope setting (#10 Env. or DL 
Env.), Orientation is automatically set for Portrait.  
The Paper Feed method for this printer is always 
Auto Feeder.

Click the Advanced button to customize the current 
Print Mode. You will see the Print Mode Properties 
dialog box.

 Print Mode Properties Dialog Box

Displays the version number of the printer driver and 
the copyright information.

Restores all settings to their default settings.
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� Page Layout Tab

Page Size Usually the Page Size is set with the software 
application. If the printer driver Page Size setting is 
not the same as the page size selected by the 
software application, you must change it here. Click 
the down-arrow and select the correct page size 
from the drop-down list.

 Changing the Page Size

Orientation Click either button to select an Orientation.

Portrait For normal printing
Landscape For documents rotated 90 degrees 

for printing
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Printing Type Click the appropriate button to select how you want 
to lay out the print job. You’ll want to select “Normal-
size Printing” for most print jobs.

 Printing Type Settings

Printer Paper Size Allows you to select the size of the paper loaded in 
the printer after you have selected Scaled, Page 
Layout, Booklet, or Poster Printing. Click the down-
arrow and select a paper size from the drop-down 
list. If the size selected for the Printer Paper Size is 
not the same as the size selected for Paper Size 
above, then the printed document is enlarged or 
reduced as required to fit the size of the paper in the 
printer.

Preview area Allows you to preview how the printed document will 
appear before executing the print job. If you have 
selected a stamp or artistic background for the 
document, you can preview how these will appear.
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Background Printing Allows printing jobs to execute in the background 
while you perform tasks with other software 
applications. Background Printing is normally 
enabled to allow you to use all of the features on the 
Page Layout tab. Click the Background Printing box 
to turn this feature on and off.

Tip: The following features are not available 
when Background Printing is off: Copies, 
Reverse order, Collate, Duplex Printing, 
Long side stapling, Short side stapling, Page 
Layout Printing, Booklet Printing, Poster Printing, 
Printer Paper Size.

Copies Enter the number of copies (1 to 999) that you want 
to print.

Reverse Order Prints sequentially from the last page to the first so 
the copies are stacked in order as they are printed.

Collate Ensures that each copy of the document is printed 
one at a time and in the correct page order, 5, 4, 3, 
2, 1 if you selected Reverse Order, or 1, 2, 3, 4, 5 if 
you did not select Reverse Order. When this feature 
is off, the specified number of copies for each page 
(1, 1, 1, 2, 2, 2) is printed.
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Duplex Printing Selects whether each sheet is printed on both sides 
(front and back). Click the check box to turn this 
feature on and off. 

After you click the check box, you can select the 
binding method, which leaves extra space on the 
margin for stapling. Click the appropriate button for 
the side where you want to bind the document.

Long side stapling

Short side stapling

Tip: When you set up a print job for Duplex 
Printing, check the Media Type settings on the 
Main tab and make sure Plain Paper is selected.

 Using Duplex Printing

Click this button to open the Printer Control dialog 
box.

10
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Printer setup Click this box to conduct printer setup while the print 
during spooling job is spooling. The printer will be ready to print as 

soon as data is sent to the printer after spooling is 
complete. Otherwise, the print job spools; after 
spooling is complete and the print data is sent to the 
printer, printer setup begins.

Using Duplex Printing

You can print a document with printing on both sides of each sheet and 
specify the size of the margin for binding the left side or top of the printed 
document.

You can execute duplex printing only with plain paper or Canon Bubble 
Jet paper. If the document contains dense color images, which require a 
large amount of ink to print, you may not be able to use Duplex Printing 
because the ink will show on the other side of the page.

12

BackLong side
Stapling

BackShort side
Stapling

Note
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1 On the Page Layout tab, click the Duplex Printing box.

2 For the binding method, click the button for “Long side stapling” or “Short 
side stapling.”

When you execute Duplex Printing, you must print one side, and then set 
the ejected page back in the sheet feeder to print on the other side.  When 
the print job starts, the first side prints. Follow the instructions on screen to 
load the printed sheet and click the OK button to print on the other side.

Note
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� Printing Type Settings
You make the Printing Type settings on the Page Layout tab.

Normal-size Printing

Normal-size Printing Prints the document at normal size without 
enlargement or reduction. After using Scaled, Page 
Layout, Booklet, or Poster Printing, click this 
button to restore normal size printing.

1

1



103Printing With Windows

Windows Printer Driver Features

Scaled Printing
Scaled Printing allows you to automatically enlarge or reduce the size of the printed page 
by loading larger or smaller paper in the printer and changing the Printer Paper Size setting.

Scaled Printing Click the button to enable scaled printing. After 
you click this button, the Scaling spinbox appears on 
the right.

Scaling Enter a number directly into the entry box or use the 
arrows on the spinbox to set the percentage of 
enlargement or reduction. You can enter a number 
within the range 10 to 400%.
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Page Layout Printing
Use Page Layout Printing to print two or four pages at reduced size on one sheet of paper. 
This printing method not only saves paper, it is also useful for printing double-page pictures 
or charts, and printing pages for binding.

Page Layout Printing Allows you to print 2 or 4 document pages on the 
same sheet. Click the button  to enable Page 
Layout Printing. After you click the button, the 
Specify button appears on the right.

Click this button to open the Page Layout Printing 
dialog box.

Pages Select the number of pages that you want to print on 
one sheet. 
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Page Order Select the order in which you want the pages to print 
on the sheet.

Frame Border Click the check box to print a frame border around 
each document page.

Booklet Printing
Booklet Printing is a special feature of Two-sided Printing. The pages are printed four to a 
sheet (two pages each on front and back) and ordered in such a way that the pages will be 
numbered consecutively after they are folded together and bound.

Booklet Printing Click the button to enable Booklet Printing. After you 
you click the button, the Specify button appears on 
the right.

Click this button to open the Booklet Printing dialog 
box.
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Insert blank page Determines how pages are arranged.

None All pages printed in order with no 
blank pages inserted

Right page Right pages printed as blank pages

Left page Left pages printed as blank pages

Tip: For and the settings may change 
depending on the Page Size and Orientation 
settings.

Staple left side Select the side where the printed document is to be 
stapled. Click this button to print the pages for 
stapling on the left side.

Stapling margin Enter a number to set the width of the stapling 
margin, measured from the center of the page.

Frame Border Click the check box to print a frame border around 
each document page.
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Poster Printing
Poster Printing allows you to print an original enlarged to print on 4, 9, or 16 sheets.  You 
can then cut along the marks that print on the page margins and paste or tape the sheets 
together to form one large poster.

Poster Printing Enlarges the original image then divides and prints it 
onto the number of sheets that you specify. The 
printed sheets can be assembled to form one large
poster.

Click this button to open the Poster Printing dialog 
box.
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Image divisions Click the button to select the number of pages for 
the image to be printed on.

2 x 2  Total of 4 pages print

3 x 3  Total of 9 pages print

4 x 4  Total of 16 pages print

Tip: The greater the number of pages, the larger 
the poster.

Print “Cut/Paste” Click the check box to print “Cut” or “Paste” in the
in margins margins to be used as guidelines when assembling 

the poster.

Print “Cut/Paste” Click the check box to print dotted lines in the
lines in margins margins to be used as guidelines when assembling 

the poster.

Preview area

• In the preview area, click any page to de-select it 
for printing. Pages with artistic backgrounds are 
not printed.

• Right-click the preview area to open the pop-up 
menu and select “Print all pages” to print all pages.

• Right-click the preview area to open the pop-up 
menu and select “Delete all pages” to delete all the 
pages.
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� Stamp/Background Tab
A selection of default stamps (IMPORTANT, CONFIDENTIAL, etc.) are available for 
immediate use, or you can create your own stamps in bold color with borders.

You can also print a colorful bitmap file behind text as a background to create an artistic 
effect. By adjusting the density of the background printing, you can experiment with a 
variety of effects.

Stamp Select one of the default stamps from the drop-down 
list. 

Place stamp over text Click this check box to print the selected stamp over 
the underlying text on the document page.

Stamp first page only Click this check box to print the stamp only on the 
first page of the document.
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Click this button to adjust the settings of the selected 
stamp or to create a new stamp.

 Using the Stamp Settings Properties 
 Dialog Box

Background Select a background pattern from the drop-down list. 

Background first Click this check box to print the background only
page only on the first page of the document. Otherwise, the 

background prints on every page of the document.

Click this button to adjust the settings for the 
selected background or to create a new background.

 Using the Background Settings 
 Properties Dialog Box

Preview area The stamp and background that you select are 
displayed in the preview area so you can see how 
the page will appear after printing.
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� Using the Stamp Settings Properties Dialog Box
Click the Define Stamp button on the Stamp/Background tab to open the Stamp Settings 
Properties dialog box. Use the Text, Color, Placement, and Save Setting tabs to create and 
position a stamp for printing.

The screen below shows the “SECRET” stamp selected. If None is 
selected under Stamp on the Stamp/Background tab, nothing is displayed 
in the preview area after you click the Define Stamp button until you enter 
some text for the new stamp in the Stamp Text box.

  Text tab Define the text and font of the 
stamp.

  Color tab Specify the color of the stamp.

  Placement tab Specify the position of the 
stamp.

  Save settings Specify the name of the new 
stamp.

Use the online help to find out about each setting.

Note
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� Using the Background Settings Properties Dialog Box
Click the Select Background button to open the Background Settings Properties dialog box. 
Use this dialog box to select backgrounds for display. Two artistic backgrounds, Sample 1 
and Sample 2, are provided.

Background tab Specify the file to use as the background, the layout 
of the file, and the intensity.

Save settings Specify the name of the new background.

Use the online help to find out about each setting.
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� Maintenance Tab
Use the Maintenance tab to perform routine tasks like cleaning the print heads and 
changing ink tanks. To start a procedure, click an icon and, when a message is displayed, 
click the OK button.

Print Head Cleaning Clean the print heads when the print quality is not 
satisfactory.

Click to clean the print head

Click to deep clean the print head
 Cleaning the Print Head

1

2

3

4

5

6 7

11



114Printing With Windows

Windows Printer Driver Features

Deep cleaning the print heads consumes ink. Deep clean the print heads 
only after consecutive print head cleanings fail to improve the print quality.

Test Prints Click either button to start a test print.

Prints the standard demonstration sheet

Prints the Nozzle Check Pattern you use to 
check the condition of the print heads

 Printing a Nozzle Check Pattern
 Performing the Test Print

Change Ink Tank Click the appropriate icon when you need to replace 
an ink tank. 

Replace the black ink tank in the BC-10 Black 
BJ Cartridge

Replace the color ink tank in the BC-11e Color 
BJ Cartridge or BC-12e Photo BJ Cartridge

Replace the black ink tank in the BC-11e Color 
BJ Cartridge or BC-12e Photo BJ Cartridge

Replace both black and color ink tanks in the 
BC-11e Color BJ Cartridge or BC-12e Photo 
BJ Cartridge

 Replacing Ink Tanks

Note
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Change BJ Cartridge Click the appropriate button when you need to 
replace a BJ cartridge.

Install new BC-10 Black BJ Cartridge

Replace BC-11e Color BJ Cartridge or BC-12e 
Photo BJ Cartridge

Replace BC-10 Black BJ Cartridge

Install a new BC-11e Color BJ Cartridge or 
BC-12e Photo BJ Cartridge

 Replacing a BJ Cartridge

Power Click to turn off power to the printer.

Opens the BJ Printer Status Monitor.

 Using the BJ Printer Status Monitor

Opens the Custom Setting dialog box.

Click the check box to turn on the low-ink 
alert and then click the Send button to enable  
the setting on the printer.
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� Print Mode Properties Dialog Box
You open the Print Mode Properties dialog box by clicking the Advanced button on the 
Main tab. The name of the currently selected print mode icon is displayed in the title bar 
(Standard Properties, DTP Properties, etc.).

Quality tab

BJ Cartridge Same as the BJ Cartridge option on the Main tab.

 Main Tab

Grayscale Print Same as the Grayscale Print option on the Main tab.

 Main Tab

Media Type Same as the Media Type option on the Main tab.

 Main Tab
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Paper Feed Click the down-arrow and select paper feed method 
from the drop-down list.

Auto Feeder Select for continuous paper feed from 
the Sheet Feeder.

Manual Feed Select for manual feed, one sheet at 
a time.

Print Quality Drag the button on the slide bar left or right to adjust 
the quality of the printed image.

Slide the button to the right to print a better quality 
image and slide to the left to increase printing speed 
(quality may deteriorate slightly).

44
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Halftoning Select one of the four methods to create mid-range 
color tones for printing.

Automatically selects the most suitable 
method for halftoning based on the colors in 
the document.

Simplifies the halftoning process to achieve 
high-speed printing.

Creates sharper color boundaries.

Creates not only sharper boundaries but 
also creates finer intermediate tones.

Image Optimizer Smoothes photographic and graphic images by 
removing jagged edges that tend to appear when an 
image is enlarged for printing. 

Photo Optimizer Allows you to adjust the color balance of images 
captured with a digital camera. 
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Whole Page Allows you to adjust multiple graphic images on the 
document page. This setting is available only when 
the Photo Optimizer is enabled. Click the box to 
apply the Photo Optimizer option to the entire page. 
Otherwise, the Photo Optimizer is applied only to the 
graphic or photo images on the page.

 Tip: 
 •  Normally, click this box off to apply the Photo 

Optimizer only to graphic or photo images. 
However, if the page(s) contain trimmed or 
rotated images, click this check box on.

 •  The Photo Optimizer can be used with
Background Printing.

99
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Special Effects tab

Simulate Illustration Enabling this feature converts a 256-color image so 
it appears to be an illustration. 

When Simulate Illustration is on, drag the button on 
the slide bar left or right to set the Contrast to one of 
the four settings.

Set to the left for a darker image, or set to the right 
for a brighter image.

1

2

1



121Printing With Windows

Windows Printer Driver Features

Tip: You can turn on Simulate Illustration feature 
and then select one of the Monochrome Effects 
below.

When the Background Printing option on the Page Layout tab is turned off, 
all of the options on the Special Effects sheet are grayed out and disabled.

Monochrome Effects Enabling this feature converts a full-color image to a 
single color for printing. 

After clicking the check box, click the appropriate 
button to select the color (Sepia, Blue, Pink, Green).

To create your own monochrome effect, click the 
Select Color button and then drag the button on the 
slide bar left or right to adjust the color, or click the 
arrows on either end of the slide bar to adjust the 
color.

Note

22

The color is displayed 
here as it is adjusted.
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Color tab

Color Adjustment Click the check box to enable all the Color Balance 
slide bars and options.

Tip: When the Color Adjustment box is checked, 
the Color Balance, Output Style, and Brightness 
features are enabled.

Use ICM Click the check box to enable ICM (Image Color 
Management) for Windows 98.

1 2

3

4

5

6

1

22



123Printing With Windows

Windows Printer Driver Features

Tip:
• This check box appears only when the printer 

driver has been installed for Windows 98. After 
ICM is selected, all other options on the Color 
tab (Color Balance, Output Style, Brightness) 
are disabled.

• If you click the ICM check box on, make sure 
that Background Printing is selected on the 
Page/Layout tab. If Background Printing is off, 
you may not be able to use other settings 
correctly.

Intensity Drag the button on the slide bar left or right, or click 
on the left or right side of the slide bar, to adjust the 
Intensity (the amount of ink used in the print job).

Select a setting to the right for a darker image or the 
left for a lighter image, with the range –50 to +50.

3
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Color Balance Drag the buttons on the slide bars to the left or right, 
or click the arrows on either end of the slide bar, to 
adjust the color balance for each printed color.

Color balance can be adjusted within the range –50 
to +50. Slide the buttons to the left to lighten the 
colors or to the right to darken the colors.

Output Style Specifies how you prefer printed output to 
emphasize intermediate tones or produce bright 
primary colors for printed photographs and graphics.
Auto Automatically recognizes the type of 

image data and selects the best 
matching method.

Accurate Accurately reproduces intermediate 
tones such as skin, sky, and natural 
green colors.

Vivid Prints bright primary colors for 
computer business graphics, such as 
line and bar charts.

14
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Brightness Adjusts the contrast between intermediate tones 
that fall between white and black (Normal, Light, 
Dark, Very Dark). Adjusting the contrast from Light 
(no correction) to Very Dark makes the overall image 
brighter, with stronger contrast in the light areas and 
lower contrast in dark areas.

Save tab

Saved Settings panel Lists all the saved print mode icons and their names. 
Select an icon here to edit or delete icons from the 
panel. After you select an icon here, the Title and 
Description are displayed below.
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Move icon buttons Allow you to change the order of appearance of the 
print mode icons in the Choose Print Mode panel on 
the Main tab.

Select the icon in the Saved Settings panel and 
click this button to move it one position to the left 
every time you click the button.

Select the icon in the Saved Settings panel and 
click this button to move it one position to the 
right every time you click the button.

Title To save the current Quality and Color tab settings to 
a new print mode setting, enter a title here. If you 
select an icon in the Saved Settings panel, the title 
of the selected icon is displayed here.

Icon Selection Select an icon from this panel to save with a new 
print mode, or to change the icon of the print mode 
currently selected in the Saved Settings panel. 
Select a new icon here, click the Save As button, 
and enter a new name for the icon.

Description If you are saving a new print mode icon, enter a 
description that will identify the icon, or enter a new 
comment for the icon selected in the Saved Settings 
panel. Click the Save As button and enter a new 
name for the icon. You can edit the description 
displayed here. 
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Click this button to save all the tab settings (Quality, 
Special Effects, Color) with the new selected icon 
and description. You can then select the new print 
mode from the Choose Print Mode panel on the 
Main tab.

Deletes the icon selected in the Saved Settings 
panel.

Tip: This button is grayed out and disabled if a 
standard icon is selected.

Click this button to save an icon selected in the 
Saved Settings panel under another name.

Tip: This button is grayed out and disabled if a 
standard icon is selected.

Click this button to open a saved icon and restore it 
to the Choose Print Mode panel on the Main tab so 
it is available for selection.
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Using the BJ Background Monitor

The BJ Background Monitor allows you to monitor the progress of document print jobs 
executing in the background. Use the BJ Background Monitor to view print jobs queued for 
printing, remove them from the queue, or change the order of execution in the queue.

• You can use the BJ Background Monitor to adjust background printing
priorities and to change the directory to store print data files temporarily. 

• The BJ Background Monitor is available only when Background Printing
is checked on in the printer driver Page Layout tab.

� Opening the BJ Background Monitor
When the Background Printing option on the Page Layout tab is checked, the BJ 
Background Monitor button will appear automatically in the Windows taskbar when a print 
job starts.

To open the BJ Background Monitor, click the BJ Background Monitor 
button in the taskbar.

Note
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Using the BJ Background Monitor

The BJ Background Monitor opens and displays the names of the 
documents queued for printing.

Application/Print Document

Displays the name of the document and application for each document in 
the queue. The documents are listed in order of execution, and the 
document currently printing is marked with the  icon.

Page(s)/Size

Displays the number of pages in the document and the size of the file.

Time/Date

Displays the time and date that each document was selected for printing.

Drag the column boundaries 
left or right to adjust the width 
of the columns for better 
viewing.
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� Changing the Print Order in the BJ Background Monitor

• The print job that is currently printing cannot be removed from its 
position at the head of the queue.

• While the order of execution is being changed, the current print job will
automatically pause temporarily.

1 Point to the name of the document that you want to move in the queue.

2 Click and drag the document to the new position in the queue.

Note
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3 When you release the mouse button, the document will be in the new 
position.

� Cancelling a Print Job With the BJ Background Monitor

1 Click on the name of the print job you want to cancel.
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2 From the Edit menu, select Delete.

A message asks you to confirm that you want to cancel the print job.

3 Click the OK button to cancel the print job.

The document is removed from the list.
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� Closing the BJ Background Monitor

From the File menu, select Quit.

The BJ Background Monitor closes.

If you want the BJ Background Monitor to close automatically after the 
last job is printed, from the File menu, select End After Printing. This 
feature is enabled when End After Printing is marked with a check mark 
in the menu.
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While the BJ Backgrounder is displayed on the screen, you can use it to cancel or pause 
the current print job.

If several print jobs are queued in the background waiting to print, use the 
BJ Background Monitor to cancel any print job, including the job currently 
executing. You can also use the BJ Printer Status Monitor to cancel a print 
job.

� Cancelling the Current Print Job With the BJ Backgrounder

1 Click the Cancel button of the BJ Backgrounder.

A message will ask you to confirm that you want to cancel the print job.

2 Click the OK button to cancel the print job.

Note
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� Pausing a Print Job With the BJ Backgrounder

1 Click the Pause button on the BJ Backgrounder.

The current print job pauses.

2 To restart the print job, click the Resume button.

The current print job resumes printing.
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The BJ Printer Status Monitor displays the status of the current print job. If the printer runs 
out of paper, if the paper jams, or if any other problems occur, the BJ Printer Status Monitor 
will display a message that describes the problem.

In order to use the BJ Printer Status Monitor with Windows, bi-directional 
communication must be turned on and, if you are using a parallel interface 
cable, the cable must support bi-directional communication between the 
printer and the computer.

Use this procedure to set the printer driver and enable bi-directional support.

1 Open the printer driver from the Start menu.

2 Click the Details tab and click the Spool Settings button.

Note
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3 Click the button for “Enable bi-directional support for this printer” to enable 
bi-directional support.
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� Viewing the BJ Printer Status Monitor
The BJ Printer Status Monitor opens automatically every time a print job starts. 

The screen below shows a print job executing normally:

The BJ Printer Status Monitor closes automatically after the print job is 
complete.

During a print job, you will see the BJ Printer Status Monitor button in 
the taskbar.

This area graphically displays the current status of 
the printer and the progress of the print job.

Displays the appropriate icon for the BJ cartridge 
currently installed in the printer:

Color: BC-11e Color BJ Cartridge installed.

Black: BC-10 Black BJ Cartridge installed.

Photo: BC-12e Photo BJ Cartridge installed.
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• To open the BJ Printer Status Monitor when a print job is not executing, 
open the printer driver, select the Maintenance tab, and click the Start
Status Monitor button.

• If the “Display low ink warning” box is checked in the Custom Setting
dialog box, the Ink Information tab will be displayed in the BJ Printer 
Status Monitor. To open the Custom Settings dialog box, click the 
Custom Setting button on the Maintenance tab.

Note
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� Handling Errors With the BJ Printer Status Monitor
If the printer runs out of paper, if the paper jams, or if any other type of problem occurs, the 
BJ Printer Status Monitor will automatically open with a message displayed in its Printer 
Status tab.

1 Look at the Status graphic display and read the message for a description 
of the problem.

If you want to cancel the print job, click the Cancel Printing button. When 
the message asks you to confirm that you want to cancel the print job, click 
the OK button.
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2 Click the Guide tab to display a solution for the problem.

If the Next button is enabled, click it to display the next page of the text 
that will guide you to a solution for the problem.

Click the Back button to return to the previous display.

3 Follow the step-by-step instructions on the screen to solve the problem.

After you have corrected the problem, the print job will re-start 
automatically.
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� Setting the BJ Printer Status Monitor Display for Every Print Job
If you want the BJ Printer Status Monitor to open for every print job, select “Always Display 
Current Job” from the Options menu. When this command is marked with a check mark in 
the menu, the BJ Printer Status Monitor will open for every job, not only when an error 
occurs.

For more details about the BJ Status Monitor, click the Help button in the BJ Printer Status 
Monitor menu bar and select Help Topics to open online Help for the BJ Printer Status 
Monitor.

� BJ Printer Status Monitor Low-Ink Alert
When the ink supply runs low in an ink tank, the BJ Printer Status Monitor will open and 
display a low-ink alert message.

1 Look at the Status graphic display and read the message tab for a 
description of the problem.

Icon of the ink tank where ink supply is low.
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2 Click the Ink Information tab to display more details about the ink tanks.

3 Follow the step-by-step instructions on the screen to solve the problem.

After you have corrected the problem, the print job will re-start 
automatically.

If the low ink alert is grayed out, or if the Ink Information tab is not visible, 
open the printer driver, select the Maintenance tab, and click the Custom 
Setting button. In the Custom Setting dialog box, click on the “Display low 
ink warning” box.

Note
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Overview of Printing With the Macintosh Printer Driver

Selecting the Printer Driver

Opening the Macintosh Printer Driver

Changing the Paper Size Selection

Setting Up a Simple Print Job

Macintosh Printer Driver Features

Using the BJ Print Monitor

Uninstalling the Macintosh Printer Driver
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After you have created a document with your software application and you are ready to 
print, you’ll want to confirm the printer driver settings before printing.

The procedure for setting up and executing a print job may differ, 
depending on the software application. For details, refer to the software 
application documentation.

1 First, select the printer driver.

From the Apple menu, select Chooser and click the BJC-85 icon. Make 
sure that BJC-85 is selected under Connected To and click the Close box in 
the upper right corner of the window.

Note

Close box

Make sure 
BJC-85 is 
selected.
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After you select the printer driver, you do not need to select it again unless 
you want to select another printer.

2 Select the paper size for the document that you are going to print.

In the software application, open the File menu and select Page Setup to 
open the Page Setup dialog box. Use this dialog box to select the paper 
size.

• If you want to enlarge or reduce the size of the document on the page, 
click on the Scale box and enter the percent of enlargement or 
reduction, or click the arrows to open the pop-up menu and select a 
setting.

• If you want to rotate the document and print sideways relative to the 
paper feed direction, click the Orientation icon on the right.

Note

Check the Paper Size 
selection.

After selecting the paper size, 
click the OK button to close 
the dialog box.
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The paper size setting is normally selected in the software application, but 
you can also use this procedure to change the paper size selection.

3 Click the print mode icon appropriate for the print job.

In the software application, from the File menu select Print to open the Print 
dialog box then select the appropriate Print Mode icon. 

• To select another BJ cartridge, click the BJ Cartridge box and select the 
name of the BJ cartridge from the pop-up menu.

• To select another media type, click the Media Type box and select the 
name of the media from the pop-up menu.

• Paper Feed is always set to Auto Feeder.

4 Make sure the printer is turned on and that paper is set in the printer.

Note

Select the icon appropriate 
for the print job.

Selecting the 
Print Mode
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5 Start the print job.

Click the Print button to start the print job.

The BJ Print Monitor is displayed while the print job is executing.

Use these buttons 
to pause or cancel 
the current print job.

If more than one 
print job has been 
started, the print 
jobs waiting to print 
are listed here.

The name of the 
print job that is 
currently printing 
is displayed here.
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Before you can execute a print job, go to the Apple menu and select Chooser. Make sure 
that the correct printer driver is selected.

1 From the Apple menu, select Chooser.

2 Click the BJC-85 icon.
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If the BJC-85 icon is not displayed, check the printer and make sure that it 
is turned on and connected to the computer. If the printer is turned on and 
connected, then the printer driver has not been installed correctly. For 
details on installing the printer driver, see your 

 

Quick Start Guide

 

.

 

3

 

Make sure that BJC-85 is displayed in the “Connected to:” panel.

Note



151Printing With Macintosh

Selecting the Printer Driver

4 Click the Close box to close the Chooser and save the selection.

� Turning On Background Printing
To turn on background printing, in the Chooser, click the Backgrounding On button.

With background printing turned on, you can start one or more print jobs and print in the 
background while you use other software applications for other tasks.

With background printing turned on, you can use the BJ Print Monitor to manage print jobs 
queued for printing. 

 Using the BJ Print Monitor

With background printing turned off, you cannot use another software 
application until the current print job is complete.

Close 
box

Note
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Use the printer driver screens to select the paper size and other important options for a 
print job. There are two printer driver screens, the Page Setup dialog box and the Print 
dialog box.

The names of the menus and appearances of the screens may differ 
slightly, depending on the software application. For details, refer to your 
software application documentation.

 Opening the Page Setup Dialog Box

 Opening the Print Dialog Box

Note
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�  Opening the Page Setup Dialog Box

1 In the software application, open the File menu and select Page Setup.

The Page Setup dialog box opens.

2 Use this dialog box to select the paper size and direction of printing for the 
document. 

Click the OK button to close the dialog box and save your changes, or click 
the Cancel button to close without saving selections.
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� Opening the Print Dialog Box

1 In the software application, open the File menu and select Print.

The Print dialog box opens.

2 Use this dialog box to select the print quality, color, and other important 
settings for the document. 

Click the OK button to close the dialog box and save your changes, or click 
the Cancel button to close without saving selections.
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Changing the Paper Size Selection

You can usually set the paper size when you create the document in the software 
application, or you can set the paper size, the scale, and print orientation with the Page 
Setup dialog box after the document has been created.

1 From the software application, open the File menu and select Page Setup.

With some software applications, you can open the File menu, select Print, 
then click the Page Setup button in the Print dialog to open the Page Setup 
dialog box.

Note
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2 Select the Paper Size.

Click on the Paper Size box and select the paper size from the pop-up 
menu.

If Paper Size setting in the Page Setup dialog box does not match the size 
of the paper set in the printer, printing will not execute correctly.

3 Click the OK button.

Note
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Setting Up a Simple Print Job

Several print mode settings are available in the Print dialog box. You can also change the 
settings for the current print job. 

� Selecting the BJ Cartridge

1 In the software application, open the File menu and select Print.

2 Click the BJ Cartridge box and select the name of the BJ cartridge 
installed in the printer.

Select Black, Color, or Photo.

Black BC-10 Black BJ Cartridge

Color BC-11e Color BJ Cartridge 

Photo BC-12e Photo BJ Cartridge
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� Selecting the Print Media

• Some print media require special handling procedures, loading 
procedures, and handling procedures after printing. For details about
using special print media, refer to the instructions provided with the 
print media package.

• Make sure the print media loaded in the printer is selected by name in
the printer driver. If the Media Type setting does not match the print
media loaded in the printer, the print job will not execute correctly.

In the Print dialog box, click on the Media Type box and select the name of the media that is 
set in the printer.

Note
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� Selecting the Paper Feed Method
The paper feed method may be different, depending on the type of print media. Make sure 
that the paper feed method you select is appropriate for the media set in the printer.

Make sure that the paper feed method is selected correctly.

If you need to select another feed method, click on the Paper Feed box and select the 
correct method from the pop-up menu.
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� Selecting the Print Mode
By simply clicking the print mode icon appropriate for the print job, you can automatically 
select the optimum settings for Print Quality, Halftoning, Color Correction, and so forth.

Under Print Mode, click on the icon appropriate for the print job.

When you open the Print dialog box, the Text icon is automatically selected. Use this 
setting to print a document that contains text. If you are printing a color illustration or 
photograph, select the appropriate print mode icon.

Current settings are 
displayed here.
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� Print Mode Icons

 Text Select for printing text documents at normal quality.

 Graphic Select for printing graphs and other computer 
graphics with sharp color boundaries.

 Photo Select for printing photographs and other graphics 
that use gradations of color and tone.

 Manual Allows you to customize the Print Mode settings for 
special print jobs.

 Setting Up a Print Job Manually
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� Setting Up a Print Job Manually

You can select the Manual icon and select the Print Quality, Halftoning, Color Correction, 
Color Balance, and other settings for a print job.

1 Click the Manual icon, then click the Details button.

2 Select the settings for the print job.

Open the Quality, Special Effects, and Color panels and select the settings.
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3 Click the OK button to close the dialog box and return to the Print dialog 
box.

The settings you have selected will be used to execute the print job.

� Registering Manual Settings for Future Use
After selecting the settings manually, you can execute the current print job, or you can 
register the settings under a name so you can use them again whenever needed.

To register manual settings

1 In the Print dialog box, click the Apply button.

The Register Settings dialog box opens. Use this dialog box to register the 
settings under a name of your choice.
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To retrieve registered manual settings for another print job

1 In the Print dialog box, click the Apply button.

2 Click the name of the registered settings that you want to use and click the 
Import button.

3 Click the Close button to return to the Print dialog box.

Click the OK button to start the print job with the imported settings.
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� Page Setup Dialog Box

Paper Size Click this option and from the pop-up menu select a 
paper size for printing.

Scale Enter a setting from 25% to 400% to set the rate of 
reduction or enlargement, or click the arrow  icon 
and select a setting from the pop-up menu.

Orientation Click to determine the orientation of the printed 
document.

Click for normal print jobs.

Click to rotate the image 90 degrees, relative 
to the direction of paper feed.

1

2

3

4 5

6
7

1

2

3
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Preview area Graphically displays the print area and orientation of 
the document, relative to the paper size.

Save Settings Click this button on to save the Page Setup dialog 
box settings.

Click the Paper Size item and select Custom1, 
Custom2, or Custom3 from the pop-up menu to 
enable the Custom button and then click the 
Custom button to open the Custom dialog box.  Use 
the options in this dialog box to define and register a 
custom paper size. 

 Custom Dialog Box

Click this button to open the Printer Utility dialog 
box. Use this dialog box to perform print head 
cleaning, printing test prints, and changing ink 
cartridges.

4

5

6

7
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� Custom Dialog Box
Click the Paper Size item and select Custom1, Custom2, or Custom3 to enable the Custom 
button. Then click the Custom button to open the Custom dialog box.

Media Enter a name for the custom paper size in this box.

Unit Click a button to select the units of measure.

mm Define the custom paper size in
millimeters

inch Define the custom paper size in inches

Paper Size Enter the dimensions for Height and Width, using 
the units you selected above. You can enter 
numbers within the following range:

Height 3.94 to 23.00 inches 
(100.0 to 584.2 mm)

Width 3.94 to 9.50 inches
(100.0 to 241.3 mm )

1

2

3

4

1

2

3
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Click this button to register the new paper size under 
the name you entered. The next time you open the 
Paper Size pop-up menu, this name will be available 
for selection.

� Printer Utility Dialog Box
In the Page Setup dialog box, click the Utilities button to open the Printer Utility dialog box. 
Then click the panel switch and from the pop-up menu, select Cleaning, Test Print, Change 
Ink Tank, Change BJ Cartridge, or Special Settings to change the panel display.

 Print Head Cleaning panel

 Test Print panel

 Change Ink Tank panel

 Change BJ Cartridge panel

 Special Settings panel

4
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Print Head Cleaning panel
In the Printer Utility dialog box, click the panel switch, and select Print Head Cleaning from 
the pop-up menu. The Print Head Cleaning panel displays the icons used to start print head 
cleaning and print head deep cleaning.

Print head cleaning Click these icons to clean the print heads.

Click to clean the print heads if the print heads 
have become clogged and print quality has 
deteriorated.

Click to deep clean (flush) the print heads if 
five consecutive cleanings with the print 
cleaning icon above does not solve the 
problem.

Deep print head cleaning consumes a large amount of ink, so use it only 
after five consecutive print head cleanings do not solve your printing 
problem.

1

1

Note
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Test Print panel
In the Printer Utility dialog box, click the panel switch, and select Test Print from the pop-up 
menu. The Test Print panel displays the icons to start the test prints.

Test Print Click an icon to start a test print.

Click to start printing the printer demonstration 
sheet.

Click to start printing a Nozzle Check Pattern.

1

1
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Change Ink Tank panel
In the Printer Utility dialog box, click the panel switch, and select Ink Tank Replacement 
from the pop-up menu. The Ink Tank Replacement panel displays the panel with the icons 
used to change the ink tanks.

Change Ink Tank Select the icon for the ink tank that you are going
to replace.

Click to replace the black ink tank in the BC-10 
Black BJ Cartridge.

Click to replace the color ink tank in the 
BC-11e Color BJ Cartridge or BC-12e Photo BJ 
Cartridge (whichever is installed in the printer).

Click to replace black ink tank in the BC-11e 
Color BJ Cartridge or BC-12e Photo BJ 
Cartridge (whichever is installed in the printer).

1

2

1
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Click to replace both the black and color ink 
tanks in the BC-11e Color BJ Cartridge or 
BC-12e Photo BJ Cartridge (whichever is 
installed in the printer).

Click to close the Printer Utility dialog box.

Change BJ Cartridge panel
In the Printer Utility dialog box, click the panel switch, and select BJ Cartridge Replacement 
from the pop-up menu. The BJ Cartridge Replacement panel displays the panel with the 
icon used to change the BJ cartridge.

Change BJ Cartridge Click this icon to change the BJ cartridge 
installed in the printer with another BJ
cartridge or the optional IS-12 Color Image
Scanner Cartridge.

2

1

1
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Special Settings panel
In the Printer Utility dialog box, click the panel switch, and select Special Settings from the 
pop-up menu. The Special Settings panel displays the icon used to select the Low Ink 
Warning feature.

Low Ink Warning Click the check box on, then click the Send button
to turn on the low ink alert.

1

1
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� Print Dialog Box

Pages To print all the pages in the document, click the All 
button on. To print only part of the document, click 
the From button on then enter the page numbers to 
be printed.

Copies Type in the number of copies to be printed 
(1 to 999).

BJ Cartridge Click this item, or the  icon and then select the 
BJ cartridge from the pop-up menu.

Black Selects the BC-10 Black BJ Cartridge

Color Selects the BC-11e Color BJ Cartridge 

Photo Selects the BC-12e Photo BJ Cartridge

1

2

3

4

5

6

11

10
9

8
7

Current print settings are displayed here

1

2

3
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Media Type Click this item or the  icon and then select the 
name of the media type from the pop-up menu. 

Paper Feed Click this item or the  icon and then select the 
name of the paper feed method from the pop-up 
menu.

Auto Feeder Select for continuous feed from the
 sheet feeder

Manual Select for manual feed one sheet at
a time

Print Grayscale Click this check box on to print grayscale.

Prints color documents in grayscale

Prints color documents in color

Print Mode Select the icon that best matches the content of the 
print job. Selecting a print mode icon automatically 
sets the optimum Print Quality, Halftoning, Color 
Correction, Color Balance, and other settings.

Click the Manual icon to enable the Details 
button, then click the Details button to open the 
Detailed Setting dialog box so you can select the 
print settings manually. 

 Setting Up a Print Job Manually

4

5

6

7

8
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Click this button to open the Options dialog box. Use 
this dialog box to select the page printing sequence, 
print destination, and page layout. 

 Options Dialog Box

Click this button to open the Register Settings dialog 
box. Use this dialog box to register a set of print 
settings, or to import registered print settings.

Click this button to start the print job.

If you press and hold down the option key on the keyboard, the button is replaced by 
the button. Click the Preview button to preview the print job on the screen. 

 Preview Dialog Box

9

10

11
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� Detailed Setting Dialog Box

To open the Detailed Setting dialog box, in the Print dialog click the Manual icon under 
Print Mode and then click the Details button.

Quality panel
In the Detailed Setting dialog box, click the Quality icon to open the Quality panel.

Panel switching Click an icon to change the panel display for the 
selected item.

Click to open the Quality panel.

Click to open the Special effects panel.

Click to open the Color panel.

2

3

4

5

Presented on all three Detailed Setting panels.

1
Graphic representation 
of the Print Quality 
setting selected on the 
slide bar.Presented on all 

three Detailed 
Setting panels.

6

1



178Printing With Macintosh

Macintosh Printer Driver Features

Print Quality Slide the button on the slider bar to the left or right to 
adjust the Print Quality.

Drag the button right for higher quality, or drag it left 
for faster printing speed with less quality.

Tip: Some Print Quality selections may not be 
available, depending on the BJ cartridge and 
media selected for the print job.

Halftoning Click an icon to select the method used to create 
halftones with arrayed ink dots.

Select to print images with clearly defined 
boundaries between primary colors and large 
areas of uniform color. Best selection for color 
business graphics like charts, tables, etc.

Select to print images with subtle boundaries 
and a wide range of colors and tones. Best 
selection for photographs.

2

3
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Photo Optimizer Select to adjust the color balance of a photographic 
image scanned or captured with a digital camera. 
This setting can correct underexposed or 
overexposed photographs.

Click the check box to use Photo Optimizer, which 
improves the appearance of photographic images.

Whole Page Selects what part of the page is selected for 
adjustment with the Photo Optimizer. Click the box 
to apply Photo Optimizer to multiply images on 
one page to adjust images individually. Otherwise, 
Photo Optimizer is applied to the whole page.

Tip: The default setting for the Whole Page is off. 
Check the box on if the page contains trimmed 
or rotated images on the page. With the Whole 
Page checked on, printing may be slower.

Restore Defaults Click this button to reset all options in the dialog box 
to their default settings.

4

5

6
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Special Effects panel

In the Print dialog, click the Manual icon under Print Mode then click the Details button. 
In the Detailed Setting dialog box, click the Special effects icon to open the Special Effects 
panel.

Simulate Illustration Converts a full color image into a simulated 
illustration. Check the box to convert to a simulated 
illustration. Otherwise, the image prints with normal, 
full color.

Contrast of the simulated illustration can be adjusted 
through four steps by sliding the button on the slide 
bar left or right.

Slide right for a brighter image, left for a darker 
image.

2

1

1
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Tip: You turn on the Simulate Illustration feature 
then select one of the Monochrome Effects 
below to combine these features.

Monochrome Effects Displays a full color image in one color that you 
select from the list below. Click the check box to 
enable the color choices so you can apply a single 
color to a full color image for printing. Otherwise, the 
Monochrome Effects selections are disabled.

To select a color:

Click the button of the colors you want to apply to 
the image: Sepia, Blue, Pink, or Green.

To create your own color:

Click the Select Color button, then drag the button 
on the slide bar left or right to adjust the color.

The adjusted color is displayed here as you move 
the button left or right.

2
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Color panel

In the Print dialog, click the Manual icon under Print Mode then click the Details button. 
In the Detailed Setting dialog box, click the Color icon to open the Color panel.

Color Correction Click the item or the arrows  icon and select the 
Color Correction method from the pop-up menu.

BJ Standard Best selection for printing on the BJ 
printer. (Always selected until you 
select another.)

ColorSync Employs Apple ColorSync for color 
correction.

Tip: If you select ColorSync, be 
sure to select the Matching 
Method and Gamma Correction 
settings also.

None No color correction.

2
1

3

5

4

6
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Matching Method Click this item or the arrows  icon and select a 
setting from the pop-up menu to select the color 
matching method.

Auto Select for automatic selection of the 
matching method (Photo or Graphic) 
based on the content of the document.

Photo Select to print photographs with natural 
color and tones.

Graphic Select for documents that contain 
illustrations and graphics.

Spot Color Select for a document with precise color 
specifications, like a color sample.

Printer Profiles Select the printer profile used for color correction. 
Normally, “Recommended by Canon” is selected for 
you.

Gamma Correction Click this check box if you want to adjust the level of 
color contrast. This turns Gamma Correction on. 
Otherwise, Gamma Correction is off and the printer 
driver uses standard contrast.

After you turn Gamma Correction on, move the 
button on the slide bar left or right to set a value.

2

3

4
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Color Balance For each color, move the slide left and right to adjust 
the saturation of each color.

Move right for a more intense color, move left for a 
less intense color through the range –50 to +50.

Density Drag the button on the slide bar left or right to adjust 
the overall density.

Move right to increase density, move left to decrease 
density through the range –50 to +50.

5

6
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Macintosh Printer Driver Features

� Options Dialog Box
In the Print dialog box, click the Options button to display the Options dialog box.

Destination Selects the destination of the print output. Click a  
button to select the destination.

Printer Sends print job to the printer.

Preview Displays print job in the preview area 
for viewing before printing.

PICT file Sends the print job to a PICT file.

Print in reverse order Prints in reverse order, from the last page to the first.

Check the box to print pages from the last page to 
the first so they are stacked in the correct order as 
they are ejected from the printer.

Otherwise pages are printed from the first page to 
the last.

2

1

3

5
4

6
7

1

2
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Macintosh Printer Driver Features

Print collated pages Click this check box to print collated copies. All 
pages of one copy are printed before printing the 
next copy. Otherwise, the specified number of 
copies are printed separately for each page.

Page Layout Click on this item or the arrows  icon then select 
the number of documents that you want to print on 
one sheet.

Page Order After you have set Page Layout to print more than 
one document per sheet, click this item or the 
arrows  icon then select the order of printing on 
the sheet.

Tip: These selections differ, depending on the 
number documents you select to print on one 
sheet. For details, turn on Balloon Help, open 
the pop-up menu, then point to each selection 
for a detailed explanation.

3

4

5
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Macintosh Printer Driver Features

Frame After you have set Page Layout to print more than 
one document per sheet, click this item or the 
arrows  icon then select whether you want a 
border printed around each document printed on the 
sheet. Available selections are None, Fine Line, 
Broad Line.

Preview area The preview area reflects the current Page Layout 
selections so you can confirm or adjust the settings.

6

7
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Macintosh Printer Driver Features

� Preview Dialog box
The Preview dialog box allows you to view the appearance of the document before it is 
printed and adjust the color balance. There are two ways to open the Preview dialog:

• In the Print dialog box, click the Options button, click the Preview button for 
Destination, then click the OK button to return to the Print dialog box. In the Print 
dialog box, the Preview button has replaced the Print button. Press the Preview 
button to open the Preview dialog box.

• In the Print dialog box, press the options key on the keyboard. The Print button 
is replaced by the Preview button. Click the Preview button to display the 
Preview dialog box.

Starts the print job.

Closes the Preview dialog and cancels the print job.

2
1

3

5

4

67

1

2



189Printing With Macintosh

Macintosh Printer Driver Features

 Enables the changes you make in the dialog box. 
After you change a setting, always click the Apply 
button so the current display reflects the change.

Tip: You may notice a slight delay after pressing 
the Apply button before the image is updated.

 Click to reset all the settings to the default values.

 Density Drag the button on the slide bar left or right to adjust 
the density of the image.

 Color Balance Drag the button on the slide bar left or right to adjust 
the color balance for each color.

 Preview image View the image to see how it fits on the selected 
paper size and orientation.

Tip: All of these adjustment features are 
presented on the Detail Setting dialog box. To 
open the Detail Setting dialog box, in the Print 
dialog box click the Manual icon then click the 
Details button.

3

4

5

6

7
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Macintosh Printer Driver Features

� Register Settings Dialog Box
In the Print dialog box, click the Apply button to open the Register Settings dialog box.

Settings: Lists the currently registered settings.

Click to close the Registered Settings dialog box 
and return to the Print dialog box.

Click a setting in the list then click the Import button 
to import the settings.

Tip: If you select Factory Defaults, all printer 
driver settings will be restored to their default 
settings.

2

1

3

5
4

6

1
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Macintosh Printer Driver Features

Click this button to open the New Settings Name 
dialog box. You can register all the previous selected 
printer driver settings under a new name.

Enter a name and click the OK button.

If a registered setting already exists with the same 
name that you have entered, a message will ask you 
to confirm that you want to write over it. You can 
write over the file or enter a new name.

Click the name of the registered setting in the list 
that you want to remove then click the Remove 
button.

Tip: The Factory Defaults setting cannot be 
removed from the list.

4

5
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Macintosh Printer Driver Features

Select the name of the setting in the list that you 
want to select for the default setting then click the 
Defaults button. The settings in the selected file will 
be enabled every time you open the printer driver.

A check mark is displayed with the setting selected 
for default.

6
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Using the BJ Print Monitor

The BJ Print Monitor allows you to monitor and manage the print jobs printing in the 
background. You can monitor the progress of the current print job, change the order of 
printing in the jobs queued for printing, and cancel any print job.

In order to use the BJ Print Monitor, you must select Backgrounding in the 
Chooser. If the feature is turned off, the BJ Print Monitor cannot open.
 

 Turning On Background Printing

� Opening the BJ Print Monitor
When Backgrounding is turned on in the Chooser, the BJ Print Monitor starts automatically 
as soon as you start a print job. Also the BJ Print Monitor is displayed in the application 
menu.

1 With print jobs executing in the background, open the application menu and 
select BJ Print Monitor.

Note
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Using the BJ Print Monitor

The name of the print job currently executing and the names of all print jobs 
queued for printing are listed in the order of execution in the BJ Print 
Monitor.

To display more information about the document queued for printing, 
double-click the name of the document to open the Document Information 
window.

• Document Name
The names of the documents.
The print job currently executing is 
marked with the printer        icon.

• Pages
The number of pages in each
document.

• Copies
The number of copies to be printed 
for each document.

• Receive Time
Time and date the print job was 
started.

Print job currently executing.

Print jobs queued for printing.

Note
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Using the BJ Print Monitor

� Changing the Print Order in the BJ Print Monitor

• Once a print job has started, it cannot be moved out of its position at 
the head of the queue.

• The current print job will pause while you are rearranging the order of
execution for the other print jobs.

1 Point to the name of the print job in the queue that you want to move.

2 Click and drag the selected print job to another location.

Note
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3 Release the mouse button to drop the print job at the new location.

� Cancelling a Print Job With the BJ Print Monitor

1 Click the name of the print job you want to cancel.
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2 In the BJ Print Monitor, click the Cancel icon.

The name of the document is removed from the queue.
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Using the BJ Print Monitor

� Pausing a Print Job With the BJ Print Monitor

1 To pause the currently executing print job, click the Pause Current icon.

The selected print job stops and returns to the queue status.  The current 
page is ejected from the printer.

2 To restart the paused print job, click the Restart icon.
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The paused print job starts printing again.

To delay a print job queued for printing, click the print job to select it and 
then click the Pause Selected icon. The paused print job in the queue 
is marked with the Paused icon. To return the print job to its active 
status in the queue, click the Restart Selected icon.

Note
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Using the BJ Print Monitor

� Changing the BJ Print Monitor Preferences
You can change the preferences to effect how the BJ Print Monitor is displayed, how errors 
are reported, and so on.

1 With the BJ Print Monitor open, open the File menu and select Pause 
Printing.

The current print job pauses.

2 From the File menu, select Preferences.

The Preferences dialog box opens.
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3 Click the check boxes on for the settings you want, then click the OK 
button.

Show BJ Print Monitor when printing
Displays the BJ Print Monitor window on the desktop during printing.

Ask at startup to print documents remaining in queue
Displays a dialog box when you restart the computer and asks whether
you want to continue printing the documents that were in the queue 
when you previously shut down the computer.

When a printing error needs to be reported
Selects the type of notification for problems that occur during 
background printing. 

Background priority
Sets the priority of printing relative to other processing (High, Normal, 
Low).

1

3

4

2

1

2

3

4
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� Closing the BJ Print Monitor After Print Jobs Are Completed
From the File menu, select Close Status Window.
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Uninstalling the Macintosh Printer Driver

• You must use this procedure to remove the printer driver from your
system when it is no longer needed, or before installing a new version
of the printer driver.

• Shut down all other software applications before you uninstall the printer
driver.

1 Set the Canon Creative CD-ROM in the CD-ROM drive.

2 Double-click the Printer Driver folder.

3 Double-click the folder for your language.

Note
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Uninstalling the Macintosh Printer Driver

4 Double-click the BJ Installer icon.

5 Read the License Agreement and click the Agree button.

6 In the Choose list, click BJC-85 and click the Choose button.
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Uninstalling the Macintosh Printer Driver

7 Click the Custom remove tab and click the check boxes for the items that 
you want to remove.

If a message warns you that another application is running in the 
background, click the Continue button to close the software application 
and continue with the installation.

If the open software application contains data that has not 
been saved, you may lose the data.

Click the Cancel button to cancel the installation. Save the data in the open 
software application, close the application and start the printer driver 
installation again.

8 Click the Remove button.

9 When you are prompted to re-start the computer, click the Restart button.

Note

A description of the 
selected item is 
displayed here.
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Troubleshooting

Error Messages

Problems and Solutions

Before You Call For Service

Getting Help From Canon

Servicing the Printer
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Error Messages

One of the following messages may appear when an error occurs: 

Error writing to LPT1: for Printer BJC-85

Service error xxx! Call for service!

This program has attempted an illegal operation and will shut down.

File cannot be found on the specified path or disk.

Cannot execute print due to insufficient disk space.

Waste ink tank is full! Call for service!

Cannot execute print due to insufficient memory.

Cannot execute background printing due to insufficient memory.

Paper jam!

Error No. * 300 (* alphanumeric code)

Type x Error (x integer)
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Printout is not clear or has white 
streaks

Strange characters printing
Cannot start the print job
LPT1: write error appears on the 

screen
Cannot install the printer driver
Application Error or General 

Protection Fault appears on 
the screen

Cannot print to the end of the print 
job

Paper does not feed automatically 
from the sheet feeder

Printout rotated 90 degrees
Vertical lines are broken
BJ cartridge does not return to the 

home position after 
installation

Cannot print via wireless infrared 
connections

Paper skews or jams during 
feeding

Screen colors and the printed 
color do not match

Document prints in black only
Colors are broken or uneven
Printing beyond edge of page, or 

portions of printed page are 
missing

Printer does not turn on
Printer seems to be working but 

nothing prints
Print job halts
Cannot feed paper manually
Printing blurred or smudged
Printout is excessively curled
ERROR light is orange
“Error Number: *300” appears on 

the screen and print job does 
not execute

“Type x Error” appears on the 
screen

Cannot execute background 
printing

Cannot select the printer driver in 
the Chooser

Problems and Solutions
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Problems and Solutions

� Printout is not clear or has white streaks
Low ink could cause faded characters and white lines to appear on the printout.

Try printing a Nozzle Check Pattern
Check the status of the BJ cartridge by printing the Nozzle Check Pattern.

 Printing a Nozzle Check Pattern

Look at the Nozzle Check Pattern to confirm the print quality. 

Only specific colors are faded

The specific color ink may have run out. Replace the ink tank with a new 
one. Then print a Nozzle Check Pattern to see if the printing quality has 
been restored.

The Nozzle Check Patterns are faded regardless of color

The print head may be clogged. Clean the print head. 

 Cleaning the Print Head

A normal Nozzle Check 
Pattern printed with 
BC-10 Black BJ Cartridge

A faded, broken Nozzle 
Check Pattern
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Problems and Solutions

If print quality is not restored after cleaning

Perform print head deep cleaning to flush the nozzles. Print a Nozzle 
Check Pattern to see if the printing quality has been restored. Repeat 
deep cleaning if the problem still persists. 

 Cleaning the Print Head

If print quality is not restored after deep cleaning

The ink may have run out. Replace the ink tank and print the Nozzle 
Check Pattern to see if the print quality has been restored.

 Printing a Nozzle Check Pattern

If print quality is not restored after replacing the ink tank(s)

Replace the BJ cartridge. 

 Replacing a BJ Cartridge

The print head may be worn out or the ink may have dried and ruined the 
nozzles. After replacing the BJ cartridge, print a Nozzle Check Pattern to 
see if the printing quality has been restored. 

If you will not be using the printer for an extended amount of time, leave 
the BJ cartridge installed inside the printer or remove it and keep it in the 
Ink Cartridge Storage Box to avoid damage. 

Note
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Problems and Solutions

Make sure that you are printing on the correct side of the paper
The paper that you are using to print may have only one correct print side. Plain paper, 
Bubble Jet paper, or Transparencies can be printed on either side. However, special print 
media like High Resolution Paper, Glossy Photo Paper, and High Gloss Film have only one 
correct print side. 

 Media You Can Use With This Printer

� Strange characters printing
The text or the image on the screen appears normal but the printer prints strange 
unreadable characters.

Printer Features

� Simple, compact design
The light, yet sturdy construction of 
the BJC-85 allows easy set up 
and operation, even for beginners. 

� Variety of print media
The printer produces superb color printing 
on plain paper or coated paper like Canon's 
High Resolution Paper, but for professional
jobs you may prefer one of the many special 
media you can use with this printer, like 
transparencies for OHP presentations, back 
print film, glossy photo paper, high gloss film, 
or glossy photo cards.

� Drop Modulation Technology
The BC-11e Color BJ Cartridge and 
BC-12e Photo BJ Cartridge employ 
Canon’s new dual drop technology, 
which produces  fine halftones with 
combinations of large and small dots, 
resulting in truly stunning color 
photographs on Canon special media 
like high resolution paper, glossy photo 
paper, or high gloss film.

� Easy operation
In the printer driver you only need to 
select the BJ cartridge and type of 
media for the print job to produce 
sensational results.  Printing on 
special media like back print film was 
never easier.

Normal Abnormal - Strange characters
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Problems and Solutions

Check to see if the BJC-85 printer is selected as the default printer
Select Canon BJC-85 as default printer.

Selecting the BJC-85 as the default printer

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and then click Set as Default to turn 
this selection on. Make sure there is a check mark by Set as Default.

Selecting the BJC-85 as the default printer

1 From the Apple menu, select Chooser.

2 In the Chooser, click the BJC-85 icon, then click the Close box.

Windows

Macintosh
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Problems and Solutions

Check interface cable connections at the printer and computer

Make sure that the printer is turned on.

If the orange ERROR light is flashing, see:

 ERROR Light is Orange

Make sure the parallel or USB cable is connected properly.

Make sure that the power cable is properly plugged into the power outlet.

Make sure that the power outlet is usable by connecting another electrical 
appliance to it and turning it on.

The parallel or USB cable may be defective. Replace it with a new 
cable and resume printing. Use only a recommended interface cable.

 Printer Specifications

1

2

36 5

4

11

22

33

44

55

66
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Problems and Solutions

Check to see if a print job has been canceled before completion
If you cancel a print job during printing, the data remaining in the printer may cause the 
printer to produce strange characters. In this situation, restart the computer and the printer, 
and start the print job again. 

If you are using Windows, click Start, point to Programs, click BJ Printer, then click BJ 
Printer Monitor and cancel the print job.

Determine if the problem exists only within a particular document
If unknown characters and letters are printed only for a specific document file, then the 
problem may exist within that file, or the software application that you are using. In this 
case, try typing the same text in a newly created file. If the new document prints normally 
then the problem exists in the original document file. If the same problem occurs with the 
new file, call the Canon Customer Care Center.

 Before You Call For Service
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Problems and Solutions

� Cannot start the print job
The printer does not respond when the print job is executed from the computer.

Check the printer status and its cable connections
Make sure the printer is ready for printing and that the cable is connected correctly. 

Check to see if the Canon BJC-85 printer has been selected as the default printer
Select BJC-85 as the default printer. 

Check to see if the printer port setting is correct
If the printer and the computer are connected locally, LPT1: must be selected as the printer 
port.

Selecting LPT1: as the printer port

1 Click Start, select Settings, and click Printers.

2 Right-click Canon BJC-85 and then click Properties.

3 Click the Details button.

Windows
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Problems and Solutions

4 Go to Printer Port Selection and then click LPT1: (Printer Port).

If the problem persists, make sure the printer port (LPT1) is operating 
normally.

Checking the operation status of LPT1:

1 Click Start, select Settings, and click Control Panel.

2 Double-click the System icon.

3 Select the Device Manager tab.

4 Double-click Ports (COM & LPT) and double-click Printer Port (LPT1) or 
Canon BJ Printer Port (LPT1) for Window 95.
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Problems and Solutions

5 Select the General tab. Under Device Status, read the information 
regarding printer port status.

6 Select the Resources tab. If there are any competing devices listed in the 
“Conflicting device list” at the bottom of the sheet, errors may occur during 
printing.

Delete the competing device if necessary. For details, 
refer to your Windows documentation or the manual 
you received with the device that is conflicting.

The display and the procedures above may be different depending on 
your Windows version. Refer to your Windows documentation for 
complete instructions. 

Note

Windows
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Problems and Solutions

Check to make sure that the printer has been selected with the Chooser
Make sure that BJC-85 is selected with the Chooser. Also make sure that the 
correct printer port is selected.

Selecting the printer with the Chooser

1 From the Apple menu, select Chooser.

2 Click the BJC-85 icon.

3 Click the Close box.

Check to see if you are printing a large amount of text or a large image
A large amount of data could slow down the print job because the computer must spend 
more time to process data and send it to the printer. This is common when printing a very 
large photographic image or a large amount of text. The computer processing speed, which 
is affected by the system (CPU, memory, space available on the hard disk, cache, interface, 
etc.), also affects the amount of time required to process a print job. Refer to your computer 
documentation for details.

Macintosh
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Problems and Solutions

Check the BJ cartridge by printing a Nozzle Check Pattern
Use the printer operation panel to print a Nozzle Check Pattern.

 Printing a Nozzle Check Pattern

If the Nozzle Check Pattern does not print ...

The printer may be damaged. Call the Canon Customer Care Center.

 Before You Call For Service

If the Nozzle Check Pattern prints normally ...

There may be a problem in the software application, or the interface cable 
could be damaged or not plugged in correctly. Execute a test print.

 Printing the Test Print

Try a test print
Use the printer operation panel to start a Demonstration test print and check the results.

 Printing the Test Print

If the test print does not execute ...

The interface cable could be damaged. Replace it with the new interface 
cable.



220Troubleshooting

Problems and Solutions

If the test print executes normally ...

There could be a problem with your software application or the computer. 
Check your software settings and the computer.

 Before You Call For Service

Cannot print via the infrared port
If the print job does not start when using the infrared port, check the location of the printer in 
relation to the computer or PDA. Change the location of the printer so the infrared ports are 
facing one another at the correct distance and angle.

The distance and the angle between the infrared ports could differ with computer model, 
the PDA capability, and the surrounding environment. Keep the distance within 3 feet 
(0.8 m) and remove any object blocking the path between the infrared ports. Print data 
cannot be sent or received if an object blocks the path between the infrared ports. Start the 
print job again. 

If you see COMn Write Error or a similar message on the screen, turn the printer off, 
turn it on again, then start the print job again. The correct COM port must be selected for 
the computer or PDA. 

 Using Infrared Data Transmission
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Problems and Solutions

� LPT1: write error appears on the screen
If an error occurs when the print job is sent to parallel port LPT1, you will see a message 
similar to this:

Check the interface cable connections
Check the interface cable connections at both the computer and the printer. 

Check the printer spooling setting
The printer spooling might not be operating properly. Discontinue printer spooling and try 
printing again by sending the print data directly to the printer.

Turning off print spooling

1 Click Start, point to Settings, and click Printers.

2 Right-click Canon BJC-85 and select Properties.

3 Select the Details tab.

4 Click the Spool Settings button.
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Problems and Solutions

5 Click the button on for “Print directly to the printer” (this turns off spooling).

Make sure the printer port (LPT1) is operating properly
Check the operation status of the printer port. 

 Checking the Operation Status of LPT1

Check to see if a WPS driver is installed
The BJC-85 may not operate properly if a WPS (Windows Printing System) driver is 
installed in your computer. If the BJC-85 and WPS printer drivers have been selected for the 
same port, uninstall the WPS driver or re-set its destination to FILE.

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and select Properties.

3 Select the Details tab.
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Problems and Solutions

To uninstall the WPS driver

Refer to the documentation that came with the WPS driver. After 
uninstalling the driver, be sure to delete the WPS port.

Click the Delete Port button, select the WPS port, then click the OK 
button.

To change the WPS destination to FILE

1 Click the down-arrow for “Print using the following port” and select the 
WPS driver.

2 Click the down-arrow for “Print to the following port” and select FILE: 
(Creates a file on disk).

3 Click the Apply button and close the printer driver.
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Problems and Solutions

Check to see if the printer driver is installed properly
It is possible that the printer driver may not be installed properly. In this situation, uninstall 
the printer driver and reinstall from the beginning.

Re-installing the printer driver

1 Click Start, select Programs, click BJ Printer, then click Uninstall.

2 Click the Yes button.

3 Click the OK button to uninstall the printer driver.

4 Reinstall the printer driver. For details, refer to the Quick Start Guide.



225Troubleshooting

Problems and Solutions

� Cannot install the printer driver
If the printer driver installation was interrupted and did not continue, some possible causes 
and solutions are listed below.

Make sure that you followed the installation procedure correctly
Follow the instructions in the Quick Start Guide to install the printer driver. Make sure you 
select the correct method, based on the operating system you are using—Windows 
(Windows 98 or Windows 95) or Macintosh (iMac or PowerMac G3)—and the type of cable 
that you are using to connect the printer and computer.

Check the Canon Creative CD-ROM
The Canon Creative CD-ROM could be damaged. Check that you can read the contents of 
the CD-ROM. 

Make sure no other applications are open and running
It is strongly recommended that you shut down all applications before you run the printer 
driver installation program. Be sure to close any virus protection programs that may be 
running in the background.

Make sure that your operating system is stable
A serious error could cause Windows or the MacOS to become unstable. If you are 
experiencing a problem with the printer driver installation, re-start the computer by shutting 
it down, turning the power off, and turning it on again. Then re-install the printer driver.
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Problems and Solutions

Check to see if the following message is displayed
File cannot be found on the specified path or disk.

Make sure you load the Canon Creative CD-ROM and select the CD-ROM drive. The name 
of the drive (D:, E:, F:, etc.) depends on the computer.

� Application Error or General Protection Fault appears on the screen
An application error or general protection fault are Windows system errors. For more 
details, see your Windows online Help.

Check to see if you are using Windows 3.1 application software
If you use Windows 3.1 application software on Windows 98 or 95, it may not operate 
correctly and could cause an error. Use only Windows 98 or 95 application software. 
Contact the software manufacturer and inquire about an updated version of your Windows 
3.1 software application.

Check to see if one of the following messages has been displayed

Cannot execute print due to insufficient memory.
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Problems and Solutions

Refer to the software application manual for the amount of memory required to run the 
program. Add more memory (RAM) if required. Shut down all other software applications 
before you open the software application and try again.

Cannot execute background printing due to insufficient 
memory.

Cannot execute print due to insufficient disk space.

Delete any unnecessary files to make room on the hard disk.

Check to see if there are any errors in the document
Try printing a newly created document.

Check to see if the printer driver has been installed properly
It is possible that the printer driver may not have been installed properly. Uninstall the 
printer driver and re-install it from the beginning. See your Quick Start Guide for details.
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Problems and Solutions

� Cannot print to the end of the print job
Part of the text is missing at the bottom of the last page printed and the following pages are 
not printed.

Printer Features

� Simple, compact design
The light, yet sturdy construction of 
the BJC-85 allows easy set up 
and operation, even for beginners. 

� Variety of print media
The printer produces superb color printing 
on plain paper or coated paper like Canon's 
High Resolution Paper, but for professional
jobs you may prefer one of the many special 
media you can use with this printer, like 
transparencies for OHP presentations, back 
print film, glossy photo paper, high gloss film, 
or glossy photo cards.

� Drop Modulation Technology
The BC-11e Color BJ Cartridge and 
BC-12e Photo BJ Cartridge employ 
Canon’s new dual drop technology, 
which produces  fine halftones with 
combinations of large and small dots, 
resulting in truly stunning color 
photographs on Canon special media 
like high resolution paper, glossy photo 
paper, or high gloss film.

� Easy operation
In the printer driver you only need to 
select the BJ cartridge and type of 
media for the print job to produce 
sensational results.  Printing on 
special media like back print film was 
never easier.

Printer Features

� Simple, compact design
The light, yet sturdy construction of 
the BJC-85 allows easy set up 
and operation, even for beginners, 
and it will not require much space 
in your work area.

� Variety of print media
The printer produces superb colour printing 
on plain paper or coated paper like Canon 
High Resolution Paper HR-101, but for 
professional jobs you may prefer one of the 
many special media you can use with this 
printer, like transparencies for OHP 
presentations, back print film, fabric sheet, 
glossy photo paper, high gloss film, or 
glossy photo cards.

� Drop Modulation Technology
The Color BJ Cartridges BC-21e and 
BC-22e Photo employ Canon’s new 
dual drop technology, which produces 
fine halftones with combinations of 
large and small dots, resulting in truly 
stunning colour photographs on 
Canon special media like high 
resolution paper, glossy photo paper, 
or high gloss film.

� Easy operation
In the printer driver you only need to 
select the BJ Cartridge and type of 
media for the print job to produce 
sensational results.  Printing on 
special media like fabric sheet and 
back print film was never easier.

Normal

Abnormal (part of last page missing)
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Check the printer and interface cable
Check the printer status and the interface cable connections. 

 Check interface cable connections at the printer and computer

Check to see if paper or special print media you are using has been selected in the 
printer driver
If you are printing on a paper size that has not been selected in the printer driver or the 
software application, part of the text may be cut off. 

• Use the selected paper size, or change the paper size selection in the software 
application. 

• Check the printer driver paper size selection and make sure that it is the same as 
the paper size selected in the software application. 

• If the software application does not allow paper size selection, select the paper 
size in the printer driver.

Check to see if a WPS driver is installed
This printer may not operate properly if a WPS (Windows Printing System) driver is installed 
in your computer and selected for the same port.

 Check to see if a WPS driver is installed
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Check to see if you have disrupted the infrared data transfer in progress or activated 
another infrared communication device nearby
Do not disrupt the infrared communication between the printer data port and the computer 
port. Any physical disruption of more than 10 seconds will cause cancellation of the print 
job, and blank sheets will be ejected from the printer. Remove any physical object blocking 
the line of sight between the infrared ports on the printer and computer. 

Do not attempt to use other infrared devices nearby while a print job is executing. For 
example, using electrical home appliances such as a remote controlled TV could disrupt the 
infrared data transmission between the printer and computer and cause the print job to halt.
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� Paper does not feed automatically from the sheet feeder
If paper does not feed smoothly from the sheet feeder, the paper or special print media may 
not be set correctly.

Check to see if Manual Feed has been selected in the printer driver
Select Auto Feeder in the printer driver when you want to feed cut sheets automatically from 
the sheet feeder.

Selecting the sheet feeder (auto feeder)

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and select Properties.

3 Select the Main tab.

4 Click the Advanced button.

5 Select the Quality tab.

Windows



232Troubleshooting

Problems and Solutions

6 Click the Paper Feed line or down-arrow, and select Auto Feeder from the 
drop-down list.

Selecting the sheet feeder (auto feeder)

1 From the File menu, select Print.

2 For Paper Feed, select Auto Feeder.

Macintosh
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Follow the correct procedure to set paper in the auto sheet feeder

Always fan the stack to remove static cling before loading the sheets in the 
auto sheet feeder. Make sure the stack is perfectly flat without curls, folds, 
wrinkles, etc., then align the edge of the stack with the right side of the 
sheet feeder and insert it into the printer until it stops.

Slide the paper guide to the left edge of the paper.

The number of sheets that you can load in the sheet feeder depends on 
the kind of the paper or special print media you are using. Make sure that 
you do not exceed the maximum number of sheets allowed for the print 
media.

 Media You Can Use With This Printer

1

2

3

4

5

1

2

3
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To prevent curling, never leave paper in the sheet feeder for a long period.

Never load the following type of paper in the sheet feeder:

• Excessively thin paper (17 lb./64 g/m2 or less)
• Excessively thick paper (28 lb./105 g/m2 or more)
• Postcards
• Thick envelopes (use only US Com #10 or European DL)
• Punched or heavily embossed paper

� Printout rotated 90 degrees
If the printout is rotated 90 degrees, the Orientation setting is not correct. 

4

5
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Check to see if the correct Orientation has been selected
Select portrait if the text is printed in landscape orientation.

Selecting the orientation

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and select Properties.

3 Select the Paper tab.

4 Click Portrait to print lengthwise to the direction of paper feed.

Some software applications allow you to select the Orientation for the print 
job. If you select the Orientation with the software application, you must 
select the identical setting with the printer driver. If the software 
application does not allow selection of the Orientation, you must use the 
printer driver Orientation selection.

Windows

Note
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Selecting the orientation

1 From the File menu, select Page Setup.

2 For the Orientation setting, click the icon.

� Vertical lines are broken
Vertical lines in the printed document are broken or jagged.

Make sure the BJ cartridge is correctly installed
Remove the BJ cartridge and install it correctly. Make sure the triangular marks on the 
BJ cartridge and holder are aligned then press down gently on the raised, left side of the 
BJ cartridge until you hear it lock in place.

Macintosh

Align marks
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Check the Print Quality setting
Use the Print Quality slide bar to select Fine.

Selecting Fine for Print Quality

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and select Properties.

3 Select the Main tab.

4 Click the Advanced button.

5 On the Quality tab, drag the Print Quality slide bar completely to the right 
to select Fine.

Windows
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Selecting Fine for Print Quality

1 From the File menu, select Print. 

2 Under Print Mode, click the Manual icon.

3 Click the Details button. 

4 Click the Quality icon.

5 Drag the Print Quality slide bar completely to the right to select Fine.

Macintosh
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� BJ cartridge does not return to the home position after installation
After the BJ cartridge is installed in the printer, the cartridge holder does not return to the 
home position.

After replacing the BJ cartridge or an ink tank, the cartridge holder does not return to the 
home position. When the CARTRIDGE button is pressed, the printer beeps but the POWER 
light remains flashing.

Make sure the BJ cartridge is installed correctly
Turn the printer off, wait a few seconds, turn it back on, and then re-install the BJ cartridge.

 Replacing a BJ Cartridge

If the BJ cartridge and holder do not return to the home position, then remove the 
BJ cartridge and install another BJ cartridge.

It takes approximately 2 seconds for the printer to recognize a newly 
installed BJ cartridge. During this time, the cartridge holder will not return 
to the home position, even after you press the CARTRIDGE button.

Home position is on the right.

Note
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� Cannot print via wireless infrared connections
The print job does not execute when the computer is set up for a wireless infrared 
connection with the printer.

Make sure the infrared driver is installed correctly
The Microsoft Infrared Communication Driver must be installed to perform printing jobs via 
infrared communication from the computer. Other infrared drivers may not operate correctly. 
Make sure that the correct infrared communication driver is installed.

 Using infrared data transmission

Some computers may require adjusting a BIOS setting to enable infrared 
communication. For details, see your computer documentation.

Make sure an infrared communication driver can be used
Open the Infrared Monitor and verify that the infrared communication has been enabled and 
that the printer has been detected.

Confirming the infrared connection

1 Click Start, select Settings, and click Control Panel.

2 Double-click the Infrared icon.

3 Select the Options tab.

Windows

Note
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4 Click the check box on for “Enable infrared communication.”

Check to see if you are using anything other than PC/AT compatible 
The computer must be PC/AT compatible to print using infrared communication. 

Make sure the correct port is selected to receive data
Make sure that COM4: (Infrared Serial (COM) Communication Port) is selected in the data 
receiving printer port to print by infrared communication. Selecting any port other than this 
port may cause an error.

The number of the serial port (COM4) may differ, depending on the 
operating system environment.

Note
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Selecting the infrared transceiver port

1 Click Start, select Settings, and click Printers. 

2 Right-click the Canon BJC-85 icon and select Properties.

3 Click the Details button.

4 Click the down-arrow for “Print to the following port” and select 
“COM4: (Infrared Serial (COM) Port.”
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Make sure the BJC-85 is connected properly with the computer via infrared port

Confirming correct infrared connection

1 Click Start, select Settings, and click Control Panel.

2 Double-click the Infrared Monitor icon.

3 Make sure that BJC-85 is listed as the currently active infrared device.
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� Paper skews or jams during feeding
If a sheet of paper skews and jams, a message is displayed:

Paper Jam!

Make sure the paper is set in the sheet feeder correctly

 Loading Paper in the Printer

Removing a paper jam

1 Slowly pull the jammed sheet straight out of the sheet feeder or out of the 
paper eject slot, whichever is easier.

• If the larger portion of the sheet is at the paper eject slot, pull it out from 
the front of the printer.

• If the larger portion of the sheet is on the sheet feeder, pull it out from the 
sheet feeder.
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• Press the paper release lever if necessary.

2 Remove the jammed paper.

After the paper is removed, the print job resumes automatically.

Paper Release Lever
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� Screen colors and the printed color do not match
The colors on the printout are unsatisfactory. For example, on-screen blue is printed purple 
or deep red, or on-screen light green appears deep green or weak yellow (strong red). Light 
green appears deep green (weak yellow).

Determine if the print head needs to be cleaned
The print head could be clogged or the ink may have run out when the colors on the printout 
do not match the screen.

1 Print a Nozzle Check Pattern.

 Printing a Nozzle Check Pattern

2 Clean the print head.

 Cleaning the Print Head

Determine if only certain colors are unsatisfactory
Adjust the printer driver color setting to match the colors.

Adjusting the color

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and select Properties.

3 Select the Main tab.

4 Click the Advanced button.

Windows
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5 Select the Color tab.

6 Click the Color Adjustment box; make sure a check mark appears.

Adjusting the color

1 From the File menu, select Print.

2 Under Print Mode, click the Manual icon.

3 Click the Details button.

Macintosh
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4 Click the Color icon.

� Document prints in black only
A document that contains colored text or images prints only black ink.

Check to see if the BC-11e Color BJ Cartridge is installed
Press the CARTRIDGE button to move the cartridge holder to the center and open the 
cartridge cover to see if a BC-11e Color BJ Cartridge is installed. Always use a BC-11e 
Color BJ Cartridge for color printing.

Make sure that Grayscale Print is turned off
While Grayscale Print is selected, all colors will print in black and white. For color printing, 
click the Grayscale Print box to remove the check mark.

Turning Grayscale Print off

1 Click Start, select Settings, and click Printers.

2 Right-click the BJC-85 icon and select Properties from the pop-up menu.

3 Select the Main tab.

Windows



249Troubleshooting

Problems and Solutions

4 Click the Grayscale Print box to remove the check mark.

Turning Grayscale Print off

1 From the File menu, select Print.

2 In the Print dialog box, click the Print Grayscale box to remove the check 
mark.

Macintosh
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Make sure the color settings are correct in the software application
Some application software may contain a dialog box with an option to select black and white 
only. Change this setting to enable color printing.

Make sure the BJC-85 is selected as default printer
It is necessary to select the BJC-85 as the default printer. If another black and white printer 
is selected as the default printer, then the BJC-85 printer could print black ink only.

 Check to see if the BJC-85 printer is selected as the default printer

� Colors are broken or uneven
Printed colors are faded, broken or uneven, compared to the colors on the screen.

Make sure the correct BJ cartridge and media type are selected for the print job
Check the printer driver settings, and make sure that the correct BJ Cartridge and Media 
Type settings are selected for the print job.

Selecting the BJ Cartridge and Media Type

1 Click Start, select Settings, and click Printers.

2 Right-click the BJC-85 icon and select Properties from the pop-up menu.

3 Select the Main tab.

Windows
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4 Select the BJ Cartridge and Media Type for the print job.

Selecting the BJ Cartridge and Media Type

1 From the File menu, select Print.

2 In the Print dialog box, select the BJ Cartridge and Media Type for the 
print job.

Make sure that Canon ink tanks are installed in the BJ cartridge
The color quality may degrade if you use ink from other manufacturers. For best quality, use 
Canon ink tanks.

Macintosh
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� Printing beyond the edge of a page, or portions of a printed page 
    are missing
The print start position is incorrect, causing the end of the page to extend onto the next 
sheet. If the print start position is incorrect, this can cause the print area to shift and appear 
out of position at the top, bottom, left, or right on the printed sheet.

Determine if you are printing on a paper size different from what is selected in the 
application software
Make sure you use the paper size selected in the software application. Select the correct 
paper size setting in the software application.

Selecting the paper size

Setting the correct margins in the software application ensures that the 
print area will be centered on each page of the document. For details 
about setting the margins for a document, refer to your software 
application documentation.

Right margin

Bottom margin

Top margin

Left margin
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• If the print area shifts to the top, increase the top margin, and decrease 
the bottom margin.

• If the print area shifts to the left, increase the left margin, and decrease 
the right margin.

• If the print area shifts to the bottom, increase the bottom margin, and 
decrease the top margin. (If the bottom margin is not adjustable in the 
software application, then reduce the number of lines on a page to 
increase the bottom margin.)

• If the print area shifts to the right, increase the right margin, and 
decrease the left margin. (If the right margin is not adjustable in the 
software application, then reduce the number of characters in a line of a 
text to increase the right margin.)

Determine if you are printing on a page size different than the page size selected in 
the printer driver
The print area will shift to the top left if you are printing on a paper larger than what is 
selected in the printer driver, and will shift to the bottom right if you print on a paper size 
smaller than what is selected in the printer driver. Select the page size in the printer driver.

Determine if the Scale print option is selected
If you are attempting to execute a Scale print, make sure the rate of enlargement/reduction 
is set correctly and make sure that the Page Size selection is correct.

Determine if you are printing on a page size shorter than what is selected in the 
software application
Make sure you use the page size that is selected in the software application.
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Determine if the top margin value in the software application is too large
Reduce the top margin value to the minimum allowed by the software application. If this is 
not possible, then reduce the number of lines allowed per printed page. Refer to your 
software application documentation for details.

� Printer does not turn on
The POWER light does not come on when you press the POWER button.

Check the printer and power cable

Connect the power cord to the printer and plug the power cord securely 
into the power outlet.

Press the POWER button again to see if the POWER light comes on.

Plug other electrical appliances into the same power outlet to see if it is 
working.

If the power outlet is overloaded, then the printer will automatically turn 
off. If this occurs, unplug the printer for a few moments and plug it in again.

1
2

4

3

1

2

3
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� Printer seems to be working but nothing prints
The printer is operating but only blank pages are ejected.

Remove the BJ Cartridge and make sure that the orange protective tape was 
removed from the print head
The ink will not flow with the orange protective tape attached. Make sure the orange tape is 
removed before installing a BJ cartridge in the printer. 

Print a nozzle check pattern
Print a nozzle check pattern to confirm that the print quality has been restored. 

 Printing a Nozzle Check Pattern

If the nozzle check pattern prints ...

A problem probably exists in the interface cable connection, the infrared 
communication environment, or software application.

Do not touch the 
print head area or 
electrical contacts.

Orange 
Protective Tape

Orange 
Protective Cap
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If the Nozzle Check Pattern does not print ...

Execute a print head cleaning and print head deep cleaning. 

 Cleaning the Print Head

If the printing cannot be restored after five print head cleanings then the 
ink may have run out. Replace the ink tank with a new one. 

 Replacing a BJ Cartridge

� Print job halts
The print job halts before it has completed.

Determine if the print job contains a large color image
High resolution pictures or images could cause the print job to pause temporarily due to the 
time required to process the large amount of data being sent. The print process should 
resume normally.

Check for the following message

Paper Jam!

A sheet of paper is jammed in the printer. Remove it to resume printing.

 Removing a Paper Jam
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Determine how long the printer has been in constant operation
Continuous printing for an extended length of time could cause the print head to overheat 
and cause it to stop. The print head will stop for a few moments at the end of each pass to 
allow it to cool off after it has become overheated.

During heavy duty printing of large areas of dark color, the printer may automatically halt to 
protect the print head from damage. In such a case, further printing is not possible until the 
print head has completely cooled. Turn off the printer and wait approximately 15 minutes.

If the print head has overheated, do not touch the print head until it has 
cooled.

Caution
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� Cannot feed paper manually 
The printer would not accept a sheet of paper inserted manually.

Check to see if the paper is set correctly

Always fan the stack to remove static cling before loading the sheets in the sheet feeder. 
Make sure the stack is perfectly flat without curls, folds, wrinkles, etc., then align the edge of 
the stack with the right side of the sheet feeder and insert it into the printer until it stops.

Slide the paper guide to the left edge of the paper.

To prevent curling, do not leave paper in the sheet feeder for a long period.

Do not load the following type of paper in the sheet feeder:

• Excessively thin paper (17 lb./64 g/m2 or less)

• Excessively thick paper (28 lb./105 g/m2 or more)

• Postcards

• Thick envelopes (use only US Com #10 or European DL)

• Punched or heavily embossed paper
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Selecting Manual Feed

1 Click Start, select Settings, and click Printers.

2 Right-click the BJC-85 icon and select Properties from the pop-up menu.

3 Select the Main tab.

4 Click the Advanced button.

5 On the Quality tab, click on the Paper Feed box and select Manual Feed 
from the drop-down list.

Windows
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Selecting Manual Feed

1 From the File menu, select Print.

2 In the Print dialog box, click on the Paper Feed box or down-arrow and 
select Manual from the pop-up menu.

� Printing blurred or smudged

Determine if you are printing on plain paper with Print Quality set for Fine
Printing in the Fine mode could result in excess ink on the paper. Reduce the print quality to 
avoid blurring or smudging.

 Printing With Windows

 Printing With Macintosh

Check to see if the paper thickness is within the specified thickness
Do not use paper thicker than 28 lb. (106 g/m2) to avoid blurring or smudging on the paper.

Macintosh
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Determine if the document exceeds the recommended print area
Adjust the setting to print within the recommended print area. Printing outside the 
recommended printing area could cause blurring or smudging.

 Printing Area

If you are using glossy paper, make sure that you print on the glossy side only
Always load glossy paper with the glossy side facing up.

Check to see if the paper is curled or bent
To remove the curl, bend the sheet gently in the direction opposite the curl.

� Printout is excessively curled
The printed sheet is excessively curled, wrinkled, or warped.

Determine if you are printing an image or picture that has dense colors
Printing an image or picture with dense colors requires a large amount of ink and could curl 
or wrinkle the paper. For such print jobs, use High Resolution Paper or Glossy Paper. These 
sheets have specially coated surfaces designed to increase the absorption of the ink, which 
avoids curling or wrinkling.

Special print media must be printed on the correct print side.

 Media You Can Use With This Printer

Check Intensity setting in the printer driver
To reduce wrinkling and curling, reduce the amount of ink used in the print job.

Note
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Lowering the Intensity setting

1 Open the printer driver.

2 On the Main tab, click the Advanced button then select the Color tab.

3 Slide the button on the Intensity slide bar to the left to reduce the amount 
of ink used in the print job.

Lowering the Density setting

1 From the File menu, select Print.

2 In the Print dialog box, click the Manual icon then click the Details 
button.

3 In the Detailed Setting dialog box, click the Color icon.

4 Drag the button on the Density slide bar to the left to reduce the amount of 
ink used in the print job.

Windows

Macintosh
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� ERROR light is orange 
The orange ERROR light comes on, the printer beeps, and the printer does not operate.

The printer will beep when an error occurs and the orange ERROR light will come on or 
flash to let you know when and what type of error has occurred. You may need to turn the 
printer off and turn it on again in order to identify the problem.

Make sure that the paper is set correctly
The orange light will flash and the printer will beep to alert you that the paper has not fed 
into the printer. If there is no paper in the sheet feeder, then load some paper. If the paper is 
not straight in the sheet feeder, then straighten it and try again.

Check to see if the following message is displayed on the screen

Paper Jam!

If paper is jammed inside the printer, the printer will beep twice and the orange ERROR 
light will flash. Remove the jammed paper and set a new sheet of paper to resume printing.

 Loading Paper in the Printer

Check to see if the BJ cartridge has been removed
If the BJ cartridge has been removed during printing, or if the BJ cartridge failed electrically, 
the printer will beep three times and the orange ERROR light will flash. Re-install the BJ 
cartridge in the cartridge holder if it has been removed, or install a new BJ cartridge to 
resume printing.

 Replacing a BJ Cartridge
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Check to see if you have installed the wrong BJ cartridge for the print job
If the BJ cartridge is not appropriate for the print job, or if you attempt to start a print job with 
the optional Scanner Cartridge installed, the printer will beep 4 times and the orange 
ERROR light will flash. Install the correct BJ cartridge to resume printing.

Check the ink level in the ink tanks
If the low-ink alert has been turned on, the orange ERROR light will flash and tell you which 
ink tank is low by the number of flashes. You can continue the print job until the ink runs out 
by pressing the RESUME button, but immediate replacement of the ink tank is 
recommended. Use the printer driver or the printer’s operation panel to reset the low-ink 
alert after replacing the ink tank. 

 Using the Low-Ink Alert

Check to see if you have stopped the BJ cartridge replacement
If you discontinue the BJ cartridge replacement, the printer will beep 3 times and the 
orange ERROR light will flash. Press the CARTRIDGE button to continue BJ cartridge 
replacement. If you intend to use the printer in this situation, then press the RESUME 
button.
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Check to see if the orange ERROR light is flashing
The printer beeps and the orange ERROR light flashes continuously. If there is no paper 
jam, or the BJ cartridge has not been removed incorrectly, an error may have occurred in 
the printer. Refer to the table below for a solution.

ERROR 
Light

Beeps Meaning Solution

Lights 
and 
remains 
on

1 Paper not set in the sheet 
feeder correctly

Remove the paper from the auto sheet feeder and load it 
correctly.

2 Paper jam Remove the paper jam.
3 BJ cartridge not installed Install a BJ cartridge correctly.
4 Correct BJ cartridge not 

installed
Replace with a correct BJ cartridge.

Flashing 2 The ink is low This is a precaution. Press RESUME to continue. Replace the 
ink tank as soon as possible.

3 BJ cartridge is being 
replaced

When BJ cartridge is replaced, press the RESUME button to 
resume printing.

4 Battery is low (using 
optional portable kit)

Change the optional battery pack.

5 Waste ink tank is full You may be able to print by pressing the RESUME button but 
the waste ink tank needs to be replaced soon. Call the Canon 
Customer Care Center.

Before You Call For Service
Both 
ERROR 
and 
POWER 
lights 
flashing

1-7
9-11

An error occurred inside 
the printer

A serious error may have occurred. Turn the printer off. Wait 
several minutes, then turn it back on. If the error still persists, 
call the Canon Customer Care Center.

Before You Call For Service
8 Printer is overheated A serious error may have occurred. Turn the printer off for 

approximately 15 minutes and then turn it back on. If the error 
persists, replace the BJ cartridge. If this does not correct the 
problem, call the Canon Customer Care Center.

Before You Call For Service
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The following messages may also be displayed in the BJ Printer Status Monitor.

Waste ink tank full! Call for service!

Service error xxx! Call for service!

� “Error Number: *300” appears on the screen and print job does 
not execute

This is a Macintosh error message where the * is replaced with a letter.

Make sure that the printer is turned on
Make sure that the POWER light is green. When the POWER light is flashing green, the 
printer is warming up. Wait a few moments for the POWER light to stop flashing. The printer 
is ready when the green POWER light remains on. 

 Printer does not turn on

Check the printer and the interface cable
Check the printer status and the connection of the printer interface cable connections. 

 Check interface cable connections at the printer and computer

Check to see if the background printing is operating properly
Follow this procedure to disable background printing and try to execute the print job again.

1 From the Apple menu, choose Chooser.

2 Click the BJC-85 icon.

Macintosh
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3 Click the Backgrounding button off.

If you cannot execute background printing, correct this problem as soon 
as possible. 

 Cannot execute background printing

Make sure that the printer driver has been installed correctly
There may be a problem with the printer driver. Uninstall it and install the printer driver 
again.

The problem may exist within the printer driver. Uninstall the printer driver and reinstall it.

 Printing With Macintosh

Note
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� “Type x Error” appears on the screen
This is a Macintosh printer error where “x” is replaced with a number.

Determine if any other software applications are open
If you are running other software applications during a print job, it is possible that the 
required amount of memory may not be available for the print job and result in this error. 
Close all software applications and start the print job again.

Determine if sufficient memory is available
Refer to the application software manual to verify that you have enough memory to run the 
software application. If you do not have sufficient memory, add memory (RAM). Refer to 
your computer documentation for details about adding memory. 

Check to see if there is sufficient available space on the hard disk of your computer
An error could occur if there is not enough space available on the hard disk of your 
computer. Secure enough hard disk space by deleting unnecessary files to create enough 
space for the creation of temporary files during printing. 

Determine if there is any problem with the document file
If unknown characters and letters are printed only for a specific document file, then the 
problem may exist within that file, or the software application that you are using. In this 
case, try typing the same text in a newly created file. If the new document prints normally 
then the problem exists in the original document file. If the same problem occurs with the 
new file, call the Canon Customer Care Center.

 Before You Call For Service

 Getting Help From Canon

Macintosh



269Troubleshooting

Problems and Solutions

Determine if the printer driver has been installed properly
There may be a problem with the printer driver. Uninstall it and install the printer driver 
again.

The problem may exist within the printer driver. Uninstall the printer driver and reinstall it.

 Printing With Macintosh

Determine if any special extension files or control panel options are in use
The printer driver could conflict with a non-Apple generated file extension or a control panel 
option. Use the Extensions Manager to change the configuration to eliminate any conflicts.

� Cannot execute background printing

Make sure that background printing has been turned on
If you cannot execute background printing, this feature may have been turned off.

Turning on background printing

1 Open the printer driver.

2 Select the Page Layout tab.

3 Click the Background Printing box; make sure a check mark appears.

Windows
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Problems and Solutions

Turning on background printing

1 From the Apple menu, choose the Chooser.

2 Click the BJC-85 icon.

3 Click the Backgrounding button to turn it on.

If background printing has been turned on, there may not be enough 
space on the disk to create temporary files for printing

Check to see if there is sufficient empty space on the hard disk of your computer.

Background printing cannot be executed if there is not enough free space available on the 
hard disk of your computer. If there is not enough space available on your hard disk, secure 
enough hard disk space by deleting unnecessary files. 

Macintosh

Macintosh
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Problems and Solutions

� Cannot select the printer driver in the Chooser
Check the following items if you cannot select the printer driver in the Chooser.

Make sure the printer is turned on
Make sure the printer is turned on and the POWER light is green. If the green light is 
flashing, then the printer is warming up. Wait a few moments for the printer to finish 
warming up. 

 Printer does not turn on

Check the printer and the interface cable connections

 Check the interface cable connections at the printer and computer

Make sure that the printer driver has been installed correctly
There may be a problem with the printer driver. Uninstall it and install the printer driver 
again.

The problem may exist in the printer driver. Uninstall the printer driver and reinstall it. 

 Printing With Macintosh

Make sure the server is turned on in the networking environment

 Printing With Macintosh

Determine if there is a problem with the networking environment
If necessary, call the system administrator. 

 Printing With Macintosh

Macintosh
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Before You Call For Service

Before you call for service, please gather some information that will help the Canon 
Customer Care Center find a solution for your problem.

Work through the troubleshooting descriptions of problems and solutions to attempt to solve 
the problem. If you cannot solve the problem, follow the steps below and prepare answers 
for some basic questions you may be asked by the technician.

� Describing the problem
• Write a short memo describing the problem.

• Note any error messages that were displayed on the screen.

• Make sure you have all the important information about your system (amount of 
memory, free disk space, current version number of the printer driver).

 Describing Your System
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Before You Call For Service

� Describing your system
Follow the simple procedures below to obtain the important information about your 
operating environment and printer driver that you will need before you call for service.

Obtaining the OS version number and amount of memory

1 Right-click the My Computer icon.

2 Select Properties from the pop-up menu.

3 From the General tab read and write down the version number of your 
operating system and the amount of memory (RAM) installed.

Windows
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Before You Call For Service

Obtaining the OS version number and amount of memory

1 From the Apple menu, select About This Computer.

2 Read and write down the version number of your operating system and 
the amount of memory (RAM) currently installed.

Determining the amount of free disk space available

1 Double-click the My Computer icon.

2 Right-click the Hard Disk icon.

3 Select Properties from the pop-up menu.

Macintosh

Windows
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Before You Call For Service

4 Read and write down the number for the amount of “Free Space” on the 
disk.

Determining the amount of free disk space available

1 On the desktop, click the Macintosh HD icon.

2 From the File menu, select Get Info., then select General Information.

Macintosh
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Before You Call For Service

3 Read and write down the number for the amount of “Available disk space.”

Obtaining the version number of the printer driver

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-85 icon and select Properties from the pop-up 
menu.

3 Select the Main tab.

4 Click the About button.

5 Read and write down the version number.

Windows
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Before You Call For Service

Obtaining the version number of the printer driver

1 On the desktop, double-click the icon of the startup disk (Macintosh HD for 
example).

2 Double-click the System folder.

3 Double-click the Extensions folder.

4 Select the BJC-85 icon.

5 From the File menu, select Get Info.

6 Read and write down the version number of the printer driver.

Macintosh
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Getting Help From Canon

Canon Computer Systems, Inc. offers a full range of customer technical support* options 
including:

• 24-hour, 7-day-a-week, toll-free automated support for troubleshooting issues on 
most current products (1-800-423-2366)

• Speak to a technician free of service charge (currently Monday – Friday 
8:00 a.m. to 10:00 p.m. and Saturday 12:00 p.m. to 6:00 p.m. EST, excluding 
holidays) for products still under warranty** (1-757-413-2848)

• Speak to a technician (currently $24.99 per call) during holidays and days/hours 
not listed above regarding urgent product questions or for products no longer 
under warranty (1-800-423-2366)

• Or for a charge of $2.50 per minute, to a maximum of $25.00 per call 
(1-900-246-1200)

• To find out about all Canon products and accessories, to download the latest 
drivers, and to explore all your technical support options incuding e-mail support, 
visit the Canon Computer Systems, Inc. Web site (www.ccsi.canon.com)

• 24-hour, toll-free Fax Retrieval System (1-800-526-4345)

• Within Canada, 24 hours a day, 7 days a week* (1-800-263-1121)

  *Support program specifics subject to change without notice.
** Refer to individual product information for warranty details.
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Servicing the Printer

Your Canon printer is designed with the latest technology to provide trouble-free operation. 
The warranty card that comes with the printer describes Canon’s limited warranty. Be sure 
to read the warranty information to find out about the different service options available to 
you.

Save your sales receipt for proof of purchase. In the event that your 
printer needs service, you will need your proof of purchase to obtain 
warranty service.

Be sure to fill out the Registration card and send it in. This will help Canon give you better 
support service.

If you seem to have a problem, try to solve it by referring to the troubleshooting information. 
If you cannot solve the problem, contact the Canon Customer Care Center. 

If you feel your printer needs servicing, contact Canon on the World Wide Web to locate the 
Canon Authorized Service Facility (ASF) nearest you. If you do not have access to the Web, 
you can call Canon.

 Getting Help From Canon

Note
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Printer Specifications

Printing Method Ink Jet Technology

Resolution (max.) 720 x 360 dpi (vertical x horizontal)

Paper Handling Auto Feed, Manual Feed

Print Speed BC-10 Black BJ Cartridge:
5 ppm

BC-11e Color BJ Cartridge:
2 ppm

Printing Direction Uni-directional (or bi-directional, depending on data format)

Print Width (max.) 8 in. (203 mm)

Line Speed Feed 70 ms/line (4.23 lines)

Line Feed Pitch 1/6, 1/8, n/60, n/180, n/360 (where “n” is programmable 
and 1 in./25.4 mm)

Character Pitch 10 cpi, 12 cpi, 15 cpi, proportional

Buffer Any setting selectable but disabled when using infrared data 
transmission
Input buffer approx. 23 KB, no download buffer
Input buffer approx. 2 KB, with 25 KB download buffer

Interfaces Parallel IEEE 1284
Universal Serial Bus (USB)
IrDA Ver. 1.1 Infrared
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Printer Specifications

BC-10 Black BJ Cartridge Print head 128 nozzles
Ink tank BCI-10 Black Ink Tank
Ink color Black
Capacity Approx. 170 pages at 5% coverage

BC-11e Color BJ Cartridge Print head 64 nozzles for black
24 nozzles each for cyan, magenta, yellow

Ink color Black, cyan, magenta, yellow
Ink tanks BCI-11 Color and Black Ink Tanks
Capacity

Black Approx. 60 pages at 15% coverage
Color Approx. 80 pages at 15% coverage

BC-12e Photo BJ Cartridge Print head 64 nozzles for black
24 nozzles each for cyan, magenta, yellow

Ink color Cyan, magenta, yellow
Ink tanks BCI-12 Color and BCI-12 Black Ink Tanks
Capacity

Black Approx. 60 pages at 15% coverage
Color Approx. 80 pages at 15% coverage

Acoustic Noise Level Approx. 45 dB (A) 

Operating Environment Temperature 41 to 95°F (5 to 35°C)
Humidity 10 to 90% RH (without condensation)

Storage Environment Temperature 32 to 95°F (0 to 35°C)
Humidity 5 to 95% RH (without condensation)

Power Source Universal AC Adapter AD-360U connected to 
AC 100V 50/60 Hz 
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Printer Specifications

Power Consumption Standby 3 W
Printing 23 W (max.)

Dimensions 11.8 x 6.2 x 2.2 in. (w × d × h)
300 x 157.6 x 57 mm (w × d × h)

Weight Approx. 3 lb. (1.4 kg) with BJ cartridge installed

Universal AC Adapter AD-360U Specifications

Dimensions 2.3 × 4.6 × 1 in. (w × d × h)
58 × 118 × 25 mm (w × d × h)

Weight Approx. 0.45 lb. (205 g)

Rated input AC100 to 240V

Rated output DC13V 1.8A
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Printing Area

This section describes the dimensions of the printing areas for print media.
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Printing Area

The shaded portions in these illustrations show the recommended printing areas for paper, 
envelopes, and special media, determined by how the media is fed to the printer for printing. 
Print quality could degrade if you print beyond the recommended margins.

 Right Margin for Custom Size

Paper Width > 8.27 in. (210 mm) Paper width - 8.0 in (203.2 mm) - Left margin width
Paper Width < 8.27 in. (210 mm) 0.13 in. (3.4 mm)
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Using the Optional IS-12 Color Scanner Cartridge

If you have purchased the Optional IS-12 Color Scanner Cartridge for your BJC-85, please 
visit Canon’s web site to download the online User’s Manual in Adobe® Acrobat® PDF 
format.

www.ccsi.canon.com

 Getting Help From Canon


	Contents
	Introduction
	Welcome
	Printer Documentation
	How to Use This Manual
	Copyright
	Disclaimer
	Trademarks
	FCC Regulations
	Canadian Radio Interference Regulations
	Safety Precautions

	Getting Ready to Print
	Printer Parts and Their Functions
	Turning the Printer On
	Setting Up and Using a Wireless Connection

	Printing
	Paper and Other Print Media
	Loading Paper in the Printer
	Changing BJ Cartridges

	Maintaining the Printer
	Printing a Nozzle Check Pattern
	Cleaning the Print Head
	Using the Low-Ink Alert
	Replacing Ink Tanks
	Replacing a BJ Cartridge
	Cleaning the Printer
	Performing the Test Print
	Transporting the Printer

	Printing With Windows
	Getting Ready to Print
	Selecting the Print Mode
	Changing the Page Size
	Windows Printer Driver Features
	Using the BJ Background Monitor
	Using the BJ Backgrounder
	Using the BJ Printer Status Monitor

	Printing With Macintosh
	Overview of Printing With the Macintosh Printer Driver
	Selecting the Printer Driver
	Opening the Macintosh Printer Driver
	Changing the Paper Size Selection
	Setting Up a Simple Print Job
	Macintosh Printer Driver Features
	Using the BJ Print Monitor
	Uninstalling the Macintosh Printer Driver

	Troubleshooting
	Error Messages
	Problems and Solutions
	Before You Call For Service
	Getting Help From Canon
	Servicing the Printer

	Specifications
	Printer Specifications
	Printing Area

	Using the Optional IS-12 Color Scanner Cartridge

		2000-04-25T17:45:40-0500
	Canon ITS
	Michael Moore
	Document is released




